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Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on
a hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description

Category

Description

HP EliteBook
8540p
Notebook PC

Product Name

HP EliteBook 8540p Notebook PC

√

HP EliteBook 8540w Mobile Workstation
Processors

HP EliteBook
8540w Mobile
Workstation

√

Intel® Core™i7 processors, Quad Core
840QM, 1.86-GHz (Turbo up to 3.06)
processor 8-MB L3 cache, 8 threads

√

√

820QM, 1.73-GHz (Turbo up to 3.06)
processor 8-MB L3 cache, 8 threads

√

√

740QM, 1.73-GHz (Turbo up to 2.80)
processor 6-MB L3 cache, 8 threads

√

√

720QM, 1.66-GHz (Turbo up to 2.80)
processor 6-MB L3 cache, 8 threads

√

√

640M, 2.80-GHz (Turbo up to 3.46) processor
4-MB L3 cache, 4 threads

√

√

620M, 2.66-GHz (Turbo up to 3.33) processor
4-MB L3 cache, 4 threads

√

√

580M, 2.66-GHz (Turbo up to 3.33) processor
3-MB L3 cache, 4 threads

√

√

560M, 2.66-GHz (Turbo up to 3.20) processor
3-MB L3 cache, 4 threads

√

√

540M, 2.53-GHz (Turbo up to 3.06) processor
3-MB L3 cache, 4 threads

√

√

520M, 2.40-GHz (Turbo up to 2.93) processor
3-MB L3 cache, 4 threads

√

√

Chipset

Intel P55 Mobile Express

√

√

Graphics

NVIDIA N10P-NS 1GB DDR3 - NVIDIA NVS
5100

√

Intel Core i7 processor, Dual Core

Intel Core i5 processors, Dual Core

NVIDIA N10P-GLM 1GB DDR3 - NVIDIA
Quadro FX 880M

√

1

Category

Panel

Memory
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Description

HP EliteBook
8540p
Notebook PC

HP EliteBook
8540w Mobile
Workstation

NVIDIA N10P-GLM4 1GB GDDR5 - NVIDIA
Quadro FX 1800M

√

ATI FirePro M5800

√

All display assemblies include 3 wireless local
area network (WLAN) antennas and 2 wireless
wide area network (WWAN) antennas

√

√

39.6-cm (15.6-in) HD

√

√

39.6-cm (15.6-in) HD with webcam

√

√

39.6-cm (15.6-in) HD+

√

√

39.6-cm (15.6-in) HD+ with webcam

√

√

39.6-cm (15.6-in) FHD

√

√

39.6-cm (15.6-in) FHD with webcam

√

√

39.6-cm (15.6-in) FHD DreamColor

√

39.6-cm (15.6-in) FHD DreamColor with
webcam

√

Support privacy filter

√

√

Four customer-accessible/upgradeable
memory module slots supporting up to 16 GB
of RAM in models that use quad-core
processors

√

√

Two customer-accessible/upgradeable memory
module slots supporting up to 8 GB of RAM in
models that use dual-core processors

√

√

Supports dual-channel memory

√

√

PC3-10600, 1333-MHz, DDR3

√

√

Supports the following configurations:

√

√

●

32768 (8192 × 4)

●

16684 (8192 × 2)

●

16684 (4096 × 4)

●

12288 (4096 × 2) + (2048 × 2)

●

8192 (8192 × 1)

●

8192 (2048 × 4)

●

8192 (4096 × 2)

●

4096 (2048 × 2)

●

4096 (4096 × 1)

●

2048 (2048 × 1)

Category

Description

HP EliteBook
8540p
Notebook PC

HP EliteBook
8540w Mobile
Workstation

Hard drives

Supports 9.5-mm, 6.35-cm (2.50-in) SATA hard
drives

√

√

Customer-accessible

√

√

Supports the following drives:

√

√

√

√

HP Mobile Data Protection System 3D

√

√

RAID 0/1 Support

√

√

Fixed (removal of 1 screw required)

√

√

Customer-accessible

√

√

Serial ATA

√

√

12.7-mm tray load

√

√

√

√

●

640-GB, 7200-rpm

●

500-GB, 7200

●

320-GB, 7200-rpm

●

320-GB, SED, 7200-rpm

●

250-GB, 7200

Supports the following solid-state drives:

Upgrade bay

●

256-GB

●

160-GB

Supports “No Drive” option
Supports the following 12.7-mm SATA optical
drives:
●

DVD±RW and CD-RW Super Multi DL
Combo Drive with LightScribe

●

Blu-ray Disc ROM with SuperMulti DVD+/R/RW DL Drive

●

Blu-ray R/RE DVD+/-RW SuperMulti DL
Drive

●

DVD-ROM Drive

Supports the following 9.5-mm SATA hard
drive:
●

500-GB, 7200-rpm

Diskette drive

Supports external USB diskette drive only

√

√

Microphone

Integrated dual-array microphone

√

√

Audio

HD audio

√

√

Stereo speakers

√

√
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Category

Description

HP EliteBook
8540p
Notebook PC

HP EliteBook
8540w Mobile
Workstation

Webcam

Integrated 2-megapixel webcam with macro
lens

√

√

Modem

56K V.92 MDC data/fax modem

√

√

Modem cable not included

√

√

Supports “No Modem” option

√

√

Intel 82577LM GbE LAN 10/100/1000 network
interface card (NIC) with iAMT

√

√

S3/S4/S5 wake on LAN

√

√

NIC power down technology

√

√

Ethernet cable not included

√

√

Ethernet

Wireless

Integrated WLAN options by way of wireless module:
Three WLAN antennas built into display
assembly

√

√

Supports “no WLAN” option

√

√

Supports the following WLAN formats:

√

√

●

Intel Wi-Fi Link 6300, 802.11a/g/n, 3 × 3

●

Intel Wi-Fi Link 6200, 802.11a/b/g/n, 2 × 2

●

Intel Wi-Fi Link 6100, 802.11a/b/g
(Ukraine and Russia only)

●

Broadcom 4322, 802.11a/b/g/n, 2 × 2

Integrated WWAN options by way of wireless module:
Two WWAN antennas built into display
assembly

√

√

GPS support

√

√

Subscriber identity module (SIM) security
(customer-accessible in battery bay)

√

√

Supports “no WWAN” option

√

√

Supports the following WWAN modules:

√

√

●

Qualcomm

●

Ericsson

Integrated personal area network (PAN) options by way of Bluetooth® module:

External media card
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Supports “no PAN” option

√

√

Broadcom Bluetooth

√

√

One ExpressCard/54 slot

√

√

Integrated Media Card Reader with SD, MMC,
MS, MSpro, xD, Memory Stick Duo support

√

√

Category

Description

HP EliteBook
8540p
Notebook PC

HP EliteBook
8540w Mobile
Workstation

Ports

Audio-in (stereo microphone)

√

√

Audio-out (stereo headphone)

√

√

DisplayPort

√

√

RJ-11 (modem)

√

√

RJ-45 (Ethernet, includes link and activity
lights)

√

√

USB 3.0 (2)

√

√

USB 2.0 (3)

√

√

eSATA

√

√

VGA (Dsub 15-pin) supporting 1600 × 1200
external resolution at 75-GHz (hot plug with
auto-detect)

√

√

1394a

√

√

3-pin AC power

√

√

Docking connector

√

√

HP Docking Station

√

√

HP Advanced Docking Station

√

√

Full-size keyboard with durable key cap
coating

√

√

Dual point (pointing stick and TouchPad) with 3
pointing stick buttons and 3 TouchPad buttons
and scroll zone

√

√

Spill-resistant design, DuraKey coating

√

√

Touch-sensitive volume up/down and mute
buttons

√

√

Five touch-sensitive launch buttons
(QuickLook/Software Setup, QuickWeb/
Browser Launch, WLAN on/off, Touchpad on/
off, Calculator launch)

√

√

AC adapter with localized cable plug support
(3-wire plug with ground pin, supports 3-pin DC
connector):

√

√

8-cell, 2.55-Ah (73-Wh) Li-ion battery

√

√

Supports 8-cell Extended Life Battery

√

√

Supports 12-cell Ultra Capacity Battery

√

√

Docking

Keyboard/pointing devices

Power requirements

●

150-W

●

120-W

●

90-W
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Category

Security

Operating system

Description

HP EliteBook
8540p
Notebook PC

HP EliteBook
8540w Mobile
Workstation

HP Fast Charge Technology

√

√

Integrated fingerprint reader

√

√

Integrated smart card reader

√

√

Security cable slot

√

√

Trusted platform module (TPM) V.1.2

√

√

Preboot authentication (password, smart card)

√

√

Windows 7 Professional 64

√

√

Windows 7 Professional 32

√

√

Windows 7 Professional with XPP images

√

√

Windows 7 Home Premium 64

√

√

Windows 7 Home Premium 32

√

√

Windows Vista Business 32

√

√

Windows Vista Home Basic

√

√

FreeDOS

√

√

Windows 7 Professional 32 with Microsoft®
Office 2007 Personal with Powerpoint

√

√

Windows 7 Professional 32 with Microsoft
Office 2007 Personal

√

√

Windows 7 Professional 32 with Microsoft
Office 2007 Professional

√

√

Windows 7 Professional 32 with Microsoft
Office 2007 Ready

√

√

Windows 7 Home Basic with Microsoft Office
Ready

√

√

Windows 7 Home Premium 32 with Microsoft
Office Ready

√

√

Windows 7 Home Premium 32 with Microsoft
Office Personal with Powerpoint

√

√

Windows 7 Home Premium 32 with Microsoft
Office Personal

√

√

Windows 7 Home Premium 32 with Microsoft
Office Professional

√

√

Windows 7 Home Premium 64 with Microsoft
Office Ready

√

√

Windows 7 Home Premium 64 with Microsoft
Office Personal with Powerpoint

√

√

Preinstalled:

Preinstalled with Microsoft® Office:
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Category

Description

HP EliteBook
8540p
Notebook PC

HP EliteBook
8540w Mobile
Workstation

Windows 7 Home Premium 64 with Microsoft
Office Personal

√

√

Windows 7 Home Premium 64 with Microsoft
Office Professional

√

√

Windows 7 Professional 64 with Microsoft
Office Ready

√

√

Windows 7 Professional 64 with Microsoft
Office Personal with Powerpoint

√

√

Windows 7 Professional 64 with Microsoft
Office Personal

√

√

Windows 7 Professional with XPP images with
Microsoft Office Ready

√

√

Windows 7 Professional with XPP images with
Microsoft Office Personal with Powerpoint

√

√

Windows 7 Professional with XPP images with
Microsoft Office Personal

√

√

Windows 7 Professional with XPP images with
Microsoft Office Professional

√

√

Windows Vista Business 32 with Microsoft
Office 2007 Ready

√

Windows Vista Business 32 with Microsoft
Office 2007 Personal with Powerpoint

√

Windows Vista Business 32 with Microsoft
Office 2007 Personal

√

√

Windows Vista Business 32 with Microsoft
2007 Professional

√

√

Windows Vista Home Basic with Microsoft
Office 2007 Ready

√

√

Windows Vista Home Basic with Microsoft
Office 2007 Personal with Powerpoint

√

√

Windows Vista Home Basic with Microsoft
Office 2007 Personal

√

√

Windows Vista Home Basic with Microsoft
Office 2007 Professional

√

√

Windows 7 Professional 64

√

√

Windows 7 Professional 32

√

√

Windows 7 Home Basic 32

√

√

Windows 7 Home Premium 64

√

√

Windows 7 Home Premium 32

√

√

Windows Vista Business 32

√

√

Restore Media:
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Category

Description

HP EliteBook
8540p
Notebook PC

HP EliteBook
8540w Mobile
Workstation

Windows Vista Home Basic

√

√

Windows XP Professional

√

√

DRDVD XP Pro

√

√

DRDVD Windows 7

√

√

DRDVD Windows 7 with WinDVD

√

√

DRDVD Windows Vista

√

√

Office Ready restore DVD

√

√

Web-only support:
Windows XP Professional 64
Windows Vista 32/64 Enterprise

√
√

√

√

√

AC adapter

√

√

Battery (system)

√

√

Hard drive

√

√

Keyboard

√

√

Memory module

√

√

Optical drive

√

√

Mini-PCI components (WLAN, WWAN, SIM)

√

√

Certified:
Novell™: SuSE Linux™ Enterprise Desktop
Serviceability
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End-user replaceable parts:

2

External component identification

Display

Component

Description

(1)

Internal display switch

Turns off the display if the display is closed while the power is on.

(2)

Internal microphones (2)

Record sound.

(3)

Webcam light

On: The webcam is in use.

(4)

Webcam

Records audio and video and captures still photographs.

(5)

Keyboard light

Illuminates the keyboard in low-light conditions when pressed.

(6)

Ambient light sensor

Automatically adjusts the display brightness based on the lighting
conditions in your environment.

Display

9

Top components
Pointing devices

Component

Description

(1)

Pointing stick*

Moves the pointer and selects or activates items on the screen.

(2)

Center pointing stick button*

Functions like the center button on an external mouse.

(3)

Right pointing stick button*

Functions like the right button on an external mouse.

(4)

TouchPad scroll zone

Scrolls up or down.

(5)

Right TouchPad button*

Functions like the right button on an external mouse.

(6)

Center TouchPad button*

Functions like the center button on an external mouse.

(7)

Left TouchPad button*

Functions like the left button on an external mouse.

(8)

TouchPad*

Moves the pointer and selects or activates items on the screen.

(9)

Left pointing stick button*

Functions like the left button on an external mouse.

*This table describes factory settings. To view or change pointing device preferences, select Start > Control Panel >
Hardware and Sound > Mouse.
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Lights

NOTE: Lights indicated by callouts 5 – 7 and 10 – 13 are always lit when the computer is powered
on. The light does not imply the function is active.
NOTE: If you press the lights indicated by callouts 5, 6, 11, 12, and 13, the light blinks for a few
seconds and turns back on.
Component

Description

(1)

●

Blue: An integrated wireless device, such as a wireless local
area network (WLAN) device and/or a Bluetooth® device, is
on.

●

Amber: All wireless devices are off.

(2)

(3)

Wireless lights (2)†

Power lights (2)*

Battery light

Wireless lights (2)†
●

On: The computer is on.

●

Blinking: The computer is in the Sleep state.

●

Off: The computer is off or in Hibernation.

●

Amber: A battery is charging.

●

Turquoise: A battery is close to full charge capacity.

●

Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins
blinking rapidly.

●

Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the computer
are fully charged. If the computer is not plugged into an
external power source, the light stays off until the battery
reaches a low battery level.

Top components
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Component

Description

(4)

●

Blinking turquoise: The hard drive or optical drive is being
accessed.

●

Amber: HP 3D DriveGuard has temporarily parked the hard
drive.

●

On: The computer is on.

●

Off: The computer is off or in the Sleep or Hibernation state.

(5)

Drive light

QuickLook light

(6)

HP QuickWeb light

●

On: The computer is on.

(7)

TouchPad light

●

Blue: TouchPad is on.

●

Amber: TouchPad is off.

(8)

Caps lock light

On: Caps lock is on.

(9)

Num lock light

On: Num lock is on.

(10)

Volume mute light

●

Blue: Computer sound is on.

●

Amber: Computer sound is off.

(11)

Volume down light

Blinking: The volume scroll zone is being used to decrease
speaker volume.

(12)

Volume up light

Blinking: The volume scroll zone is being used to increase
speaker volume.

(13)

Calculator light

●

On: The Windows calculator application is on.

●

Blinking: The Windows calculator is in use.

*The two power lights display the same information. The light on the power button is visible only when the computer is open.
The power light on the front of the computer is visible whether the computer is open or closed.
†
The two wireless lights display the same information. The light on the wireless button is visible only when the computer is
open. The wireless light on the front of the computer is visible whether the computer is open or closed.
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Buttons, switches, and fingerprint reader

Component

Description

(1)

●

When the computer is off, press the button to turn
on the computer.

●

When the computer is on, press the button to shut
down the computer.

●

When the computer is in the Sleep state, press the
button briefly to exit Sleep.

●

When the computer is in Hibernation, press the
button briefly to exit Hibernation.

Power button

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off the
computer.
To learn more about your power settings, select Start >
Control Panel > Performance and Maintenance >
Power Options.
(2)

QuickLook button

●

When the computer is off, press the button to open
HP QuickLook.

●

When the computer is on, press the button to open
Software Setup.
NOTE: If Software Setup is not available, the
default Web browser opens.

Top components
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Component

Description

(3)

●

When the computer is off, press the button to open
HP QuickWeb.

●

When the computer is on, press the button to open
the default Web browser.

QuickWeb button

(4)

Wireless button

Turns the wireless feature on or off, but does not
establish a wireless connection.

(5)

TouchPad button

Enables/disables the TouchPad.

(6)

Volume mute button

Mutes and restores speaker sound.

(7)

Volume down button

Decreases computer volume.

(8)

Volume up button

Increases computer volume.

(9)

Calculator button

Turns on the Windows calculator function.

(10)

Fingerprint reader

Allows a fingerprint logon to Windows, instead of a
password logon.

Chapter 2 External component identification

Keys

Component

Description

(1)

esc key

Displays system information when pressed in combination with
the fn key.

(2)

fn key

Executes frequently used system functions when pressed in
combination with a function key or the esc key.

(3)

Windows logo key

Displays the Windows Start menu.

(4)

Windows applications key

Displays a shortcut menu for items beneath the pointer.

(5)

Integrated numeric keypad keys

Can be used like the keys on an external numeric keypad.

(6)

Function keys

Execute frequently used system functions when pressed in
combination with the fn key.

Top components
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Front components

Component

Description

(1)

●

An integrated wireless device, such as a WLAN device, the
HP Mobile Broadband Module (select models only), and/or
a Bluetooth device, is on.

●

Amber: All wireless devices are off.

●

On: The computer is on.

●

Blinking: The computer is in the Sleep state.

●

Off: The computer is off or in Hibernation.

●

Amber: A battery is charging.

●

Turquoise: A battery is close to full charge capacity.

●

Blinking amber: A battery that is the only available power
source has reached a low battery level. When the battery
reaches a critical battery level, the battery light begins
blinking rapidly.

●

Off: If the computer is plugged into an external power
source, the light turns off when all batteries in the computer
are fully charged. If the computer is not plugged into an
external power source, the light stays off until the battery
reaches a low battery level.

●

Blinking turquoise: The hard drive or optical drive is being
accessed.

●

Amber: HP 3D DriveGuard has temporarily parked the hard
drive.

(2)

(3)

(4)
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Wireless light

Power light

Battery light

Drive light

(5)

Speakers (2)

Produce sound.

(6)

Media Card Reader

Supports the following optional digital card formats:
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●

Memory Stick

●

Memory Stick Duo (adapter required)

●

Memory Stick Pro (adapter required)

●

MultiMediaCard

●

Secure Digital (SD) Memory Card

●

xD-Picture Card

●

xD-Picture Card Type H

●

xD-Picture Card Type M

Component

Description

(7)

Display release button

Opens the computer.

(8)

Business card slot

Holds a business card in position so that the webcam can
capture an image.

Left-side components

Component

Description

(1)

USB ports (3)

Connect optional USB devices.

(2)

Vent

Enables airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(3)

DisplayPort

Connects an optional digital display device, such as a highperformance monitor or projector.

(4)

eSATA port

Connects high-performance eSATA components, such as an
eSATA external hard drive.

(5)

1394 port

Connects an optional IEEE 1394 or 1394a device, such as a
camcorder.

(6)

Audio-in (microphone) jack

Connects an optional computer headset microphone, stereo
array microphone, or monaural microphone.

(7)

Audio-out (headphone) jack

Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.
NOTE: When a device is connected to the headphone jack, the
computer speakers are disabled.

(8)

ExpressCard slot

Supports optional ExpressCards.

Left-side components
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Rear components

The vent enables airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool internal components and prevent
overheating. It is normal for the internal fan to cycle on and off during routine operation.
Component

Description

(1)

External monitor port

Connects an external VGA monitor or projector.

(2)

Power connector

Connects an AC adapter.

Right-side components

Component

Description

(1)

Smart card reader

Supports optional smart cards and Java™ Cards.

(2)

Upgrade bay

Supports an optical drive or hard drive.

(3)

3.0 SuperSpeed USB ports (2)

Connect optional USB devices and transfer data at a higher
speed than a 2.0 USB device.

(4)

RJ-45 (network) jack

Connects a network cable.

(5)

RJ-11 (modem) jack

Connects a modem cable.

(6)

Security cable slot

Attaches an optional security cable to the computer.
NOTE: The security cable is designed to act as a deterrent, but
it may not prevent the computer from being mishandled or stolen.
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Bottom components

Component

Description

(1)

SIM slot

Contains a wireless subscriber identity module (SIM) (select
models only). The SIM slot is located inside the battery bay.

(2)

Battery bay

Holds the battery.

(3)

Docking connector

Connects an optional docking device.

(4)

Vents (6)

Enable airflow to cool internal components.
NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(5)

Accessory battery connector

Connects an optional accessory battery.

(6)

Memory module compartment

Contains two expansion memory module slots.

(7)

Hard drive bay

Holds the hard drive.

(8)

Bluetooth compartment

Contains a Bluetooth device.

(9)

Wireless module compartment

Contains an HP Mobile Broadband Module.
NOTE: To prevent an unresponsive system, replace the
wireless module only with a wireless module authorized for use in
the computer by the governmental agency that regulates wireless
devices in your country or region. If you replace the module and
then receive a warning message, remove the module to restore
computer functionality, and then contact technical support
through Help and Support.

(10)

Battery release latch

Releases the battery from the battery bay.

Bottom components
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Wireless antennas (select models only)
The antennas send and receive signals from one or more wireless devices. These antennas are not
visible from the outside of the computer.

Component

Description

(1)

WWAN antennas (2)*

Send and receive wireless signals to communicate with wireless
wide area networks (WWANs).

(2)

WLAN antennas (3)*

Send and receive wireless signals to communicate with wireless
local area networks (WLANs).

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately
around the antennas free from obstructions.

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental
Notices that applies to your country or region. These notices are located in Help and Support.
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Illustrated parts catalog

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

●

Product name (1). This is the product name affixed to the front of the computer.

●

Serial number (s/n) (2). This is an alphanumeric identifier that is unique to each product.

●

Part number/Product number (p/n) (3). This number provides specific information about the
product's hardware components. The part number helps a service technician to determine what
components and parts are needed.

●

Model description (4). This is the alphanumeric identifier used to locate documents, drivers, and
support for the computer.

●

Warranty period (5). This number describes the duration (in years) of the warranty period for the
computer.

Service tag
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Item

Description

Spare part number

(1)

Display assembly (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and
cables)
For use in model 8540p:
●
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39.6-cm (15.6-in) LED, HD, AntiGlare for use in computers without a webcam
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595736-001

Item

Description

Spare part number

●

39.6-cm (15.6-in) LED, HD, AntiGlare for use in computers with a webcam

595737-001

●

39.6-cm (15.6-in) LED, FHD for use in computers without a webcam

595738-001

●

39.6-cm (15.6-in) LED, FHD for use in computers with a webcam

600755-001

●

39.6-cm (15.6-in) LED, HD+ WVA for use in computers without a webcam

595739-001

●

39.6-cm (15.6-in) LED, HD+ for use in computers with a webcam

595740-001

For use in model 8540w:

(2)

(3)

●

39.6-cm (15.6-in) LED, HD, AntiGlare for use in computers without a webcam

600756-001

●

39.6-cm (15.6-in) LED, HD, AntiGlare for use in computers with a webcam

600757-001

●

39.6-cm (15.6-in) LED, HD+ WVA for use in computers without a webcam

600760-001

●

39.6-cm (15.6-in) LED, HD+ WVA for use in computers with a webcam

600761-001

●

39.6-cm (15.6-in) LED, FHD for use in computers without a webcam

600758-001

●

39.6-cm (15.6-in) LED, FHD for use in computers with a webcam

600759-001

●

39.6-cm (15.6-in) LED, FHD, Dreamcolor for use in computers without a webcam

606979-001

●

39.6-cm (15.6-in) LED, FHD, DreamColor for use in computers with a webcam

606980-001

Switch cover
For use in model 8540p

595770-001

For use in model 8540w

595771-001

Keyboard with pointing stick (includes pointing stick and pointing stick cable)
For use in Belgium

595790-A41

For use in Brazil

595790-201

For use in Bulgaria

595790-261

For use in the Czech Republic and Slovakia

595790-A81

For use in Denmark

595790-081

For use in France

595790-051

For use in French Canada

595790-121

For use in Germany

595790-041

For use in Greece

595790-DJ1

For use in Hungary

595790-211

For use in Iceland

595790-DD1

For use in Israel

595790-BB1

For use in Italy

595790-061

For use in Japan

595790-291

For use in Latin America

595790-161

For use in the Netherlands

595790-B31

Computer major components
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Item

(4)

Description

Spare part number

For use in Norway

595790-091

For use in Portugal

595790-131

For use in Russia

595790-251

For use in Saudi Arabia

595790-171

For use in Slovenia

595790-BA1

For use in South Korea

595790-AD1

For use in Spain

595790-071

For use in Sweden

595790-B71

For use in Switzerland

595790-BG1

For use in Taiwan

595790-AB1

For use in Thailand

595790-281

For use in Turkey

595790-141

For use in the United Kingdom

595790-031

For use in the United States

595790-001

Top cover (includes TouchPad button and bracket)
For use with HP EliteBook 8540p computer models that include a fingerprint reader

595775-001

For use with HP EliteBook 8540p computer models that do not include a fingerprint reader

595776-001

For use with HP EliteBook 8540w computer models that include a fingerprint reader

595777-001

For use with HP EliteBook 8540w computer models that do not include a fingerprint reader

595778-001

Fingerprint reader board (not illustrated; includes fingerprint reader board cable)

595780-001

(5)

Fan

595769-001

(6)

Heat sink (includes replacement thermal material)

(7)

For use in computers with NVIDIA Quadro FX 1800 graphics (includes fan)

595766-001

For use in computers with NVIDIA Quadro FX 880 or NVIDIA NVS 5100 graphics (does not
include fan)

595767-001

For use in computers with ATI FirePro M5800 graphics (includes fan)

595768-001

Processor
Intel Core i7 processors, Quad Core
840QM, 1.86-GHz (Turbo up to 3.06) processor 8-MB L3 cache, 8 threads

612260-001

820QM, 1.73-GHz (Turbo up to 3.06) processor 8-MB L3 cache, 8 threads

583053-001

740QM, 1.73-GHz (Turbo up to 2.80) processor 6-MB L3 cache, 8 threads

612259-001

720QM, 1.66-GHz (Turbo up to 2.80) processor 6-MB L3 cache, 8 threads

586170-001

Intel Core i7 processor, Dual Core
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640M, 2.80-GHz (Turbo up to 3.46) processor 4-MB L3 cache, 4 threads

625826-001

620M, 2.66-GHz (Turbo up to 3.33) processor 4-MB L3 cache, 4 threads

587259-001
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Item

Description

Spare part number

Intel Core i5 processors, Dual Core

(8)

580M, 2.66-GHz (Turbo up to 3.33) processor 3-MB L3 cache, 4 threads

625825-001

560M, 2.66-GHz (Turbo up to 3.20) processor 3-MB L3 cache, 4 threads

625824-001

540M, 2.53-GHz (Turbo up to 3.06) processor 3-MB L3 cache, 4 threads

594188-001

520M, 2.40-GHz (Turbo up to 2.93) processor 3-MB L3 cache, 4 threads

594187-001

Modem module

628824-001

NOTE: The modem module spare part kit does not include a modem module cable. The
modem module cable is included in the Cable Kit, spare part number 595787-001. See
Cable Kit on page 30 for more Cable Kit spare part number information.
(9)

WLAN module
Intel Wi-Fi Link 6300, 802.11a/b/g/n for use in Andorra, Antigua and Barbuda, Argentina,
Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda,
Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile,
the People's Republic of China, Colombia, Costa Rica, Croatia, Cyprus, Czech Republic,
Denmark, Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France,
French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam, Guatemala, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, Ivory
Coast, Jamaica, Japan, Jordan, Kenya, South Korea, Kuwait, Kyrgyzstan, Latvia, Lebanon,
Martinique, US Virgin Islands, Puerto Rico, Nether Antilles, Liechtenstein, Lithuania,
Luxembourg, Malawi, Malaysia, Malta, Mauritius, Mexico, Monaco, Montenegro, Morocco,
the Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman, Pakistan, Panama,
Paraguay, Peru, Philippines, Poland, Portugal, Qatar, Romania, San Marino, Saudi Arabia,
Senegal, Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden,
Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Turkey, the United Arab
Emirates, the United Kingdom, the United States, Uruguay, Venezuela, and Vietnam

572511-001

Intel Wi-Fi Link 6200, 802.11a/b/g/n for use in Andorra, Antigua and Barbuda, Argentina,
Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda,
Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile,
the People's Republic of China, Colombia, Costa Rica, Croatia, Cyprus, Czech Republic,
Denmark, Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France,
French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam, Guatemala, Haiti,
Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, Ivory
Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Martinique,
Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta, Mauritius, Mexico,
Monaco, Montenegro, Morocco, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Nigeria, Norway, Oman, Pakistan, Panama, Paraguay, Peru, Philippines,
Poland, Portugal, Puerto Rico, Qatar, Romania, San Marino, Saudi Arabia, Senegal,
Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, Sweden,
Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Tunisia, Turkey, the United
Arab Emirates, the United Kingdom, the United States, Uruguay, the U.S. Virgin Islands,
Venezuela, and Vietnam

572509-001

Intel Wi-Fi Link 6100, 802.11a/b/g for use in Russia and Ukraine

572510-001

Broadcom 4322 AGN 802.11a/b/g/n WLAN module for use in Antigua and Barbuda,
Barbados, Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago,
the U.S. Virgin Islands, and the United States

518434-001

Computer major components
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Item

(10)

(11)

(12)

26

Description

Spare part number

Broadcom 4322 AGN 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria,
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize,
Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British
Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the
Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros,
the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica,
the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea,
Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia,
Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, GuineaBissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy,
the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco,
Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand,
Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea,
Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal,
Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan,
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan,
Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

518434-002

Graphics card (includes replacement thermal material)
NVIDIA NVS 5100 graphics card

595820-001

NVIDIA Quadro FX 880 graphics card

595821-001

NVIDIA Quadro FX 1800 graphics card

595822-001

ATI FirePro M5800 graphics card

595823-001

WWAN modules
HP un2420 Broadband Module (WWAN)

531993-001

HP hs2320 HSPA Mobile Broadband Module

574248-001

HSPA F3607 WWAN minicard module

574249-001

System board (includes replacement thermal material and VGA support bracket)
For use with the following dual-core processors: 520M, 540M, 620M

595764-001

For use with the following quad-core processors: 720QM, 820QM

595765-001

For use in Russia and the People's Republic of China with the following dual-core
processors: 520M, 540M, 620M

630293-001

For use in Russia and the People's Republic of China with the following quad-core
processors: 720QM, 820QM

630294-001

(13)

RTC battery

581075-001

(14)

Speaker assembly

595788-001

(15)

ExpressCard/audio assembly

595783-001

(16)

USB/VGA board (includes cable)

595782-001

(17)

8-cell Li-ion battery
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Item

(18)

(19)

(20)

(21)

Description

Spare part number

73-Wh battery

493976-001

68-Wh battery

592078-001

Base enclosure (includes rubber feet)
For use with HP EliteBook 8540w computer models without an RJ-11 cap

595772-001

For use with HP EliteBook 8540p computer models with an RJ-11 cap

595773-001

For use with HP EliteBook 8540p computer models without an RJ-11 cap

595774-001

Hard drive (includes hard drive bracket and screws)
640-GB, 7200-rpm

621046-001

500-GB, 7200-rpm

634919-001

500-GB, 7200-rpm (for use in the upgrade bay)

595762-001

320-GB, 7200-rpm, Self-encrypting drive (SED)

626978-001

320-GB, 7200-rpm

603783-001

250-GB, 7200-rpm

595753-001

256-GB solid-state drive

595756-001

160-GB solid-state drive

595757-001

Hard Drive Hardware Kit

630887-001

Memory modules
8-GB (PC3-10600, 1333-MHz, DDR3)

634091-001

4-GB (PC3-12800, 1600-MHz, DDR3)

641369-001

2-GB (PC3-12800, 1600-MHz, DDR3)

652972-001

Bluetooth module (does not include Bluetooth module cable)

537921-001

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable.
The Bluetooth module cable is included in the Cable Kit, spare part number 595787-001.
See Cable Kit on page 30 for more Cable Kit spare part number information.
(22)

Optical drive (includes bracket, bezel, and screws)
DVD±RW and CD-RW SuperMulti DL Combo Drive with LightScribe

595759-001

Blu-ray Disc ROM with SuperMulti DVD+/-R/RW DL Drive

595760-001

DVD-ROM Drive

595758-001

Blu-ray ROM DVD±RW SuperMulti DL Drive

595761-001

Cable Kit (not illustrated; see Cable Kit on page 30 for more Cable Kit spare part number
information)

595787-001

Computer major components
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Display components

Item

Description

(1)

Display bezel

Spare part number

For use with computer models with a webcam

595747-001

For use with computer models without a webcam

595748-001

For use with computer models with DreamColor displays

595749-001

(2)

Webcam module

583219-001

(3)

Display hinges (includes left and right hinges)
For use with computer models that do not use DreamColor displays

595742-001

For use with computer models that use DreamColor displays

595743-001

(4)

Ambient light sensor

595781-001

(5)

Display enclosure (includes antennas, microphone, and microphone mylar)
For use in HP Elite 8540p models

595744-001

For use in HP Elite 8540w models that do not use DreamColor displays

595745-001

For use in HP Elite 8540w models that use DreamColor displays

595746-001

Display cable kit, includes:
For use with HD displays

595741-001

For use with DreamColor displays

615116-001

(6a)

LCD cable, main

(6b)

LCD cable, color mapping board to panel
LCD raw display panel (not illustrated)
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39.6-cm (15.6-in) LED, HD SVA, anti-glare

623181-001

39.6-cm (15.6-in) LED, HD+ WVA, anti-glare

624643-001
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Plastics Kit

Item

Description

Spare part number

Plastics Kit:

595784-001

(1)

Bluetooth module cover

(2)

ExpressCard slot protective insert

(3)

WWAN cover

(4)

Memory module compartment cover (includes 2 captive screws, secured by C-clips)

(5)

Hard drive cover (includes 4 captive screws, secured by C-clips)
LCD hinge covers (left and right; not illustrated)
Optical drive panel (not illustrated)

Plastics Kit
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Cable Kit

Item

30

Description

Spare part number

Cable Kit:

595787-001

(1)

RJ-11 connector cable

(2)

TouchPad cable

(3)

Power connector cable

(4)

Bluetooth module cable
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Mass storage devices
Item

Description

(1)

Optical drive

(3)

Spare part number

DVD±RW and CD-RW SuperMulti DL Combo Drive with LightScribe

595759-001

Blu-ray Disc ROM with SuperMulti DVD±R/RW DL Drive

595760-001

DVD-ROM Drive

595758-001

Blu-ray ROM DVD±RW SuperMulti DL Drive

595761-001

Hard drive (includes bracket and screws)
640-GB, 7200-rpm

621046-001

500-GB, 7200-rpm

634919-001

500-GB, 7200-rpm (for use in the upgrade bay)

595762-001

320-GB, 7200-rpm, Self-encrypting drive (SED)

626978-001

320-GB, 7200-rpm

603783-001

250-GB, 7200-rpm

595753-001

256-GB solid-state drive (SSD)

595756-001

160-GB solid-state drive (SSD)

595757-001

Hard Drive Hardware Kit

630887-001

Mass storage devices
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Miscellaneous parts
Description

Spare part number

AC adapters
90-W AC adapter

463955-001
613153-001

90-W AC adapter for use in India

535593-001
613160-001

120-W AC adapter

463953-001
613154-001

150-W AC adapter

463954-001
613156-001

Battery latch kit (includes latch, knob, and spring)

595750-001

Power cords:
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For use in Argentina

490371-D01

For use in Australia

490371-011

For use in Brazil

490371-201

For use in Denmark

490371-081

For use in Europe, the Middle East, and Africa

490371-021

For use in India

490371-D01

For use in Israel

490371-BB1

For use in Italy

490371-061

For use in Japan

490371-291

For use in the People's Republic of China

490371-AA1

For use in South Africa

490371-AR1

For use in South Korea

490371-AD1

For use in Switzerland

490371-111

Power cord for use in Taiwan

490371-AB1

For use in the United Kingdom

490371-031

For use in the United States

490371-001
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Description

Spare part number

Rubber Kit (includes rubber screw covers)

595785-001

Screw Kit

595786-001

●

Phillips PM2.0×5.0 captive screw

●

Black Phillips PM2.5×12.0 captive screw

●

Silver Phillips PM2.5×12.0 captive screw

●

Phillips PM2.0×7.0 captive screw

●

Phillips PM2.0×4.0 screw

●

Phillips PM3.0×3.0 screw

●

Phillips PM2.5×5.0 screw

●

Phillips PM2.5×3.0 screw

●

Phillips PM2.0×3.0 screw

●

Black Phillips PM2.5×6.0 screw

●

Black Phillips PM2.0×5.0 screw

●

HM2.5×6.0 hex screw lock

●

Torx T8M2.5×7.0 screw

●

Torx T8M2.5×8.0 screw

●

Torx T8M2.0×8.0 screw

●

Torx T8M2.5×6.0 screw

Sequential part number listing
Spare part
number

Description

463953-001

120-W AC adapter

463954-001

150-W AC adapter

463955-001

90-W AC adapter

490371-001

Power cord for use in North America

490371-011

Power cord for use in Australia

490371-021

Power cord for use in Europe, the Middle East, and Africa

490371-031

Power cord for use in the United Kingdom

490371-061

Power cord for use in Italy

490371-081

Power cord for use in Denmark

490371-111

Power cord for use in Switzerland

490371-201

Power cord for use in Brazil
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490371-291

Power cord for use in Japan

490371-AA1

Power cord for use in the People's Republic of China

490371-AB1

Power cord for use in Taiwan

490371-AD1

Power cord for use in South Korea

490371-AR1

Power cord for use in South Africa

490371-BB1

Power cord for use in Israel

490371-D01

Power cord for use in Argentina

490371-D61

Power cord for use in India

493976-001

8-cell, 2.55-Ah (73-Wh) Li-ion battery

518434-001

Broadcom 4322 AGN 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados, Belize,
Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and the
United States

518434-002

Broadcom 4322 AGN 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra,
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas,
Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi,
Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's Republic of China,
Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti,
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea,
Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany, Ghana,
Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique,
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique,
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria,
Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland,
Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and
Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St.
Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania,
Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United
Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire,
Zambia, and Zimbabwe

531993-001

HP un2420 Broadband Module (WWAN)

535593-001

90-W AC adapter for use in India

537921-001

Bluetooth module

572509-001

Intel Wi-Fi Link 6200, 802.11a/b/g/n WLAN module for use in Andorra, Antigua and Barbuda, Argentina,
Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia and
Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile, the People's Republic of China,
Colombia, Costa Rica, Croatia, Cyprus, Czech Republic, Denmark, Dominican Republic, Ecuador, Egypt, El
Salvador, Estonia, Finland, France, French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe,
Guam, Guatemala, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy,
Ivory Coast, Jamaica, Japan, Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Martinique,
Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta, Mauritius, Mexico, Monaco, Montenegro,
Morocco, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman, Pakistan,
Panama, Paraguay, Peru, Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, San Marino, Saudi
Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain, Sri Lanka, Sweden,
Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Tunisia, Turkey, the United Arab Emirates,
the United Kingdom, the United States, Uruguay, the U.S. Virgin Islands, Venezuela, and Vietnam
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572510-001

Intel Wi-Fi Link 6100, 802.11a/b/g WLAN module for use in Russia and Ukraine

572511-001

Intel Wi-Fi Link 6300, 802.11a/b/g/n WLAN module for use in Andorra, Antigua and Barbuda, Argentina,
Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium, Bermuda, Bolivia, Bosnia and
Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands, Chile, the People's Republic of China,
Colombia, Costa Rica, Croatia, Cyprus, Czech Republic, Denmark, Dominican Republic, Ecuador, Egypt, El
Salvador, Estonia, Finland, France, French Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe,
Guam, Guatemala, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy,
Ivory Coast, Jamaica, Japan, Jordan, Kenya, South Korea, Kuwait, Kyrgyzstan, Latvia, Lebanon,
Martinique, US Virgin Islands, Puerto Rico, Nether Antilles, Liechtenstein, Lithuania, Luxembourg, Malawi,
Malaysia, Malta, Mauritius, Mexico, Monaco, Montenegro, Morocco, the Netherlands, New Zealand,
Nicaragua, Nigeria, Norway, Oman, Pakistan, Panama, Paraguay, Peru, Philippines, Poland, Portugal,
Qatar, Romania, San Marino, Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa, Spain,
Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Turkey, the United
Arab Emirates, the United Kingdom, the United States, Uruguay, Venezuela, and Vietnam

574248-001

HP hs2320 HSPA Mobile Broadband Module

574249-001

HSPA F3607 WWAN minicard module

581075-001

RTC battery

583053-001

Intel Core i7 820QM Quad Core processor, 1.73-GHz (Turbo up to 3.06), 8-MB L3 cache, 8 threads

583219-001

Webcam module

586170-001

Intel Core i7 720QM Quad Core processor, 1.66-GHz (Turbo up to 2.80), 6-MB L3 cache, 8 threads

587259-001

Intel Core i7 620M Dual Core processor, 2.66-GHz (Turbo up to 3.33), 4-MB L3 cache, 4 threads

592078-001

8-cell, 68-Wh Li-ion battery

594187-001

Intel Core i5 520M Dual Core processor, 2.40-GHz (Turbo up to 2.93), 3-MB L3 cache, 4 threads

594188-001

Intel Core i5 540M Dual Core processor, 2.53-GHz (Turbo up to 3.06), 3-MB L3 cache, 4 threads

595736-001

39.6-cm (15.6-in) LED display assembly, HD, AntiGlare for use in computers without a webcam (includes
3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

595737-001

39.6-cm (15.6-in) LED display assembly, HD, AntiGlare for use in computers with a webcam (includes 3
WLAN antenna transceivers and 2 WWAN antenna transceivers and cables)

595738-001

39.6-cm (15.6-in) LED display assembly, FHD for use in computers without a webcam (includes 3 WLAN
antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

595739-001

39.6-cm (15.6-in) LED display assembly, HD+ WVA for use in computers without a webcam (includes 3
WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

595740-001

39.6-cm (15.6-in) LED display assembly, HD+ for use in computers with a webcam (includes 3 WLAN
antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

595741-001

Display cable kit, includes LCD cable, LCD cable (system board to color mapping board), LCD cable (color
mapping board to panel)

595742-001

Display hinges for use in models that do not use DreamColor displays (includes left and right hinge)

595743-001

Display hinges for use with models with DreamColor displays (includes left and right hinge)

595744-001

Display enclosure for use in HP Elite 8540p models (includes antennas, microphone, and microphone
mylar)

595745-001

Display enclosure for use in HP Elite 8540w models that do not use DreamColor displays (includes
antennas, microphone, and microphone mylar)
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595746-001

Display enclosure for use in HP Elite 8540w models that use DreamColor displays (includes antennas,
microphone, and microphone mylar)

595747-001

Display bezel for use with computer models with a webcam

595748-001

Display bezel for use with computer models without a webcam

595749-001

Display bezel for use with computer models with DreamColor

595750-001

Battery latch kit (includes latch, knob, and spring)

595753-001

250-GB, 7200-rpm hard drive (includes hard drive bracket and screws)

595756-001

256-GB solid-state drive (SSD) (includes hard drive bracket and screws)

595757-001

160-GB solid-state drive (SSD) (includes hard drive bracket and screws)

595758-001

DVD-ROM drive

595759-001

DVD±RW and CD-RW SuperMulti DL combo drive with LightScribe

595760-001

Blu-ray Disc ROM with SuperMulti DVD±R/RW DL drive

595761-001

Blu-ray ROM DVD±RW SuperMulti DL Drive

595762-001

500-GB, 7200-rpm hard drive for use in the upgrade bay (includes hard drive bracket and screws)

595764-001

System board for use with the following dual-core processors: 520M, 540M, 620M (includes replacement
thermal material and VGA support bracket)

595765-001

System board for use with the following quad-core processors: 720QM, 820QM (includes replacement
thermal material and VGA support bracket)

595766-001

Heat sink with fan (for use in computers with NVIDIA Quadro FX 1800 graphics)

595767-001

Heat sink for use in computers with NVIDIA Quadro FX 880 or NVIDIA NVS 5100 graphics (does not
include fan)

595768-001

Heat sink for use in computers with ATI FirePro M5800 graphics (includes fan)

595769-001

Fan

595770-001

Switch cover for use in model 8540p (includes LED board and cable)

595771-001

Switch cover for use in model 8540w (includes LED board and cable)

595772-001

Base enclosure for use with HP EliteBook 8540w computer models without an RJ-11 cap

595773-001

Base enclosure for use with HP EliteBook 8540p computer models with an RJ-11 cap

595774-001

Base enclosure for use with HP EliteBook 8540p computer models without an RJ-11 cap

595775-001

Top cover for use with HP EliteBook 8540p computer models that include a fingerprint reader (includes
TouchPad button and bracket)

595776-001

Top cover for use with HP EliteBook 8540p computer models that do not include a fingerprint reader
(includes TouchPad button and bracket)

595777-001

Top cover for use with HP EliteBook 8540w computer models that include a fingerprint reader (includes
Touchpad button and bracket)

595778-001

Top cover for use with HP EliteBook 8540w computer models that do not include a fingerprint reader
(includes Touchpad button and bracket)

595780-001

Fingerprint reader board (includes fingerprint reader board cable)
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595781-001

Ambient light sensor board (includes cable)

595782-001

USB/VGA board (includes cable)

595783-001

ExpressCard/audio assembly

595784-001

Plastics Kit (see Plastics Kit on page 29 for more Plastics Kit spare part information)

595785-001

Rubber Kit (includes rubber screw covers)

595786-001

Screw Kit

595787-001

Cable Kit (see Cable Kit on page 30 for more Cable Kit spare part information)

595788-001

Speaker assembly

595790-001

Keyboard with pointing stick for use in the United States (includes keyboard and pointing stick cables)

595790-031

Keyboard with pointing stick for use in the United Kingdom (includes keyboard and pointing stick cables)

595790-041

Keyboard with pointing stick for use in Germany (includes keyboard and pointing stick cables)

595790-051

Keyboard with pointing stick for use in France (includes keyboard and pointing stick cables)

595790-061

Keyboard with pointing stick for use in Italy (includes keyboard and pointing stick cables)

595790-071

Keyboard with pointing stick for use in Spain (includes keyboard and pointing stick cables)

595790-081

Keyboard with pointing stick for use in Denmark (includes keyboard and pointing stick cables)

595790-091

Keyboard with pointing stick for use in Norway (includes keyboard and pointing stick cables)

595790-121

Keyboard with pointing stick for use in French Canada (includes keyboard and pointing stick cables)

595790-131

Keyboard with pointing stick for use in Portugal (includes keyboard and pointing stick cables)

595790-141

Keyboard with pointing stick for use in Turkey (includes keyboard and pointing stick cables)

595790-161

Keyboard with pointing stick for use in Latin America (includes keyboard and pointing stick cables)

595790-171

Keyboard with pointing stick for use in Saudi Arabia (includes keyboard and pointing stick cables)

595790-201

Keyboard with pointing stick for use in Brazil (includes keyboard and pointing stick cables)

595790-211

Keyboard with pointing stick for use in Hungary (includes keyboard and pointing stick cables)

595790-251

Keyboard with pointing stick for use in Russia (includes keyboard and pointing stick cables)

595790-261

Keyboard with pointing stick for use in Bulgaria (includes keyboard and pointing stick cables)

595790-281

Keyboard with pointing stick for use in Thailand (includes keyboard and pointing stick cables)

595790-291

Keyboard with pointing stick for use in Japan (includes keyboard and pointing stick cables)

595790-A41

Keyboard with pointing stick for use in Belgium (includes keyboard and pointing stick cables)

595790-A81

Keyboard with pointing stick for use in the Czech Republic and Slovakia (includes keyboard and pointing
stick cables)

595790-AB1

Keyboard with pointing stick for use in Taiwan (includes keyboard and pointing stick cables)

595790-AD1

Keyboard with pointing stick for use in South Korea (includes keyboard and pointing stick cables)

595790-B31

Keyboard with pointing stick for use in the Netherlands and Europe (includes keyboard and pointing stick
cables)
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595790-B71

Keyboard with pointing stick for use in Sweden (includes keyboard and pointing stick cables)

595790-BA1

Keyboard with pointing stick for use in Slovenia (includes keyboard and pointing stick cables)

595790-BB1

Keyboard with pointing stick for use in Israel (includes keyboard and pointing stick cables)

595790-BG1

Keyboard with pointing stick for use in Switzerland (includes keyboard and pointing stick cables)

595790-DD1

Keyboard with pointing stick for use in Iceland (includes keyboard and pointing stick cables)

595790-DJ1

Keyboard with pointing stick for use in Greece (includes keyboard and pointing stick cables)

595820-001

NVIDIA NVS 5100 graphics card (includes replacement thermal material)

595821-001

NVIDIA Quadro FX 880 graphics card (includes replacement thermal material)

595822-001

NVIDIA Quadro FX 1800 graphics card (includes replacement thermal material)

595823-001

ATI FirePro M5800 graphics card

600755-001

39.6-cm (15.6-in) LED display assembly, FHD for use in model 8540p computers with a webcam (includes
3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

600756-001

39.6-cm (15.6-in) LED display assembly, HD, AntiGlare for use in model 8540w computers without a
webcam (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and
cables)

600757-001

39.6-cm (15.6-in) LED display assembly, HD, AntiGlare for use in model 8540w computers with a webcam
(includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

600758-001

39.6-cm (15.6-in) LED display assembly, FHD for use in model 8540w computers without a webcam
(includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

600759-001

39.6-cm (15.6-in) LED display assembly, FHD for use in model 8540w computers with a webcam (includes
3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

600760-001

39.6-cm (15.6-in) LED display assembly, HD+ WVA for use in computers without a webcam (includes
3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

600761-001

39.6-cm (15.6-in) LED display assembly, HD+ WVA for use in computers with a webcam (includes 3 WLAN
antenna transceivers and cables and 2 WWAN antenna transceivers and cables)

603783-001

320-GB, 7200-rpm hard drive (includes hard drive bracket and screws)

606979-001

39.6-cm (15.6-in) LED display assembly, FHD, DreamColor for use in model 8540w computers without a
webcam (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and
cables)

606980-001

39.6-cm (15.6-in) LED display assembly, FHD, DreamColor for use in model 8540w computers with a
webcam (includes 3 WLAN antenna transceivers and cables and 2 WWAN antenna transceivers and
cables)

612259-001

Intel Core i7 740QM Quad Core processor, 1.73-GHz (Turbo up to 2.80), 8-MB L3 cache, 8 threads

612260-001

Intel Core i7 840QM Quad Core processor, 1.86-GHz (Turbo up to 3.06), 8-MB L3 cache, 8 threads

613153-001

90-W AC adapter

613154-001

120-W AC adapter

613156-001

150-W AC adapter

613160-001

90-W AC adapter for use in India

615116-001

Display cable for use with DreamColor displays
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621046-001

640-GB, 7200-rpm hard drive (includes hard drive bracket and screws)

623181-001

LCD raw display panel, 39.6-cm (15.6-in) LED, HD SVA, anti-glare

624643-001

LCD raw display panel, 39.6-cm (15.6-in) LED, HD+ WVA, anti-glare

625824-001

Intel Core i5 560M Dual Core processor, 2.66-GHz (Turbo up to 3.20), 3-MB L3 cache, 4 threads

625825-001

Intel Core i5 580M Dual Core processor, 2.66-GHz (Turbo up to 3.33), 3-MB L3 cache, 4 threads

625826-001

Intel Core i7 640M Dual Core processor, 2.80-GHz (Turbo up to 3.46), 4-MB L3 cache, 4 threads

626978-001

320-GB, 7200-rpm Self-encrypting (SED) hard drive (includes hard drive bracket and screws)

628824-001

Modem module for use in all countries and regions except Australia and New Zealand
NOTE: The modem module spare part kit does not include a modem module cable. The modem module
cable is included in the Cable Kit, spare part number 595787-001. See Cable Kit on page 30 for more Cable
Kit spare part number information.

630293-001

System board for use in Russia and the People's Republic of China with the following dual-core processors:
520M, 540M, 620M

630294-001

System board for use in Russia and the People's Republic of China with the following quad-core
processors: 720QM, 820QM

630887-001

Hard Drive Hardware Kit

634091-001

8-GB memory module (PC3-10600, 1333-MHz, DDR3)

634919-001

500-GB, 7200-rpm hard drive (includes hard drive bracket and screws)

641369-001

4-GB memory module (PC3-12800, 1600-MHz, DDR3)

652972-001

2-GB memory module (PC3-12800, 1600-MHz, DDR3)
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Removal and replacement procedures

Preliminary replacement requirements
Tools required
You will need the following tools to complete the removal and replacement procedures:
●

Flat-bladed screwdriver

●

Phillips P0 and P1 screwdrivers

●

Torx T8 screwdriver

Service considerations
The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.
NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.
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Cables and connectors
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.
Cables must be handled with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector whenever
possible. In all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in
such a way that they cannot be caught or snagged by parts being removed or replaced. Handle flex
cables with extreme care; these cables tear easily.

Drive handling
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to
the computer, damage to a drive, or loss of information, observe these precautions:
Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.
Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.
Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.
Handle drives on surfaces covered with at least 2.5 cm (one inch) of shock-proof foam.
Avoid dropping drives from any height onto any surface.
After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive to temperature extremes or liquids.
If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Preliminary replacement requirements

41

Grounding guidelines
Electrostatic discharge damage
Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.
A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.
An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, and then degrade in the internal layers,
reducing its life expectancy.
CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:
Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.
Before touching an electronic component, discharge static electricity by using the guidelines
described in this section.
Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
If you remove a component, place it in an electrostatic-safe container.
The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.
CAUTION: A product can be degraded by as little as 700 V.
Typical electrostatic voltage levels
Relative humidity
Event
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10%

40%

55%

Walking across carpet

35,000 V

15,000 V

7,500 V

Walking across vinyl floor

12,000 V

5,000 V

3,000 V

Motions of bench worker

6,000 V

800 V

400 V

Removing DIPS from plastic tube

2,000 V

700 V

400 V

Removing DIPS from vinyl tray

11,500 V

4,000 V

2,000 V

Removing DIPS from Styrofoam

14,500 V

5,000 V

3,500 V

Removing bubble pack from PCB

26,500 V

20,000 V

7,000 V

Packing PCBs in foam-lined box

21,000 V

11,000 V

5,000 V
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Packaging and transporting guidelines
Follow these grounding guidelines when packaging and transporting equipment:
●

To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

●

Protect ESD-sensitive parts and assemblies with conductive or approved containers or
packaging.

●

Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

●

Place items on a grounded surface before removing items from their containers.

●

Always be properly grounded when touching a component or assembly.

●

Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

●

Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines
Follow these grounding workstation guidelines:
●

Cover the workstation with approved static-shielding material.

●

Use a wrist strap connected to a properly grounded work surface and use properly grounded
tools and equipment.

●

Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

●

When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

●

Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

●

Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

●

Avoid contact with pins, leads, or circuitry.

●

Turn off power and input signals before inserting or removing connectors or test equipment.

Preliminary replacement requirements
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Equipment guidelines
Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.
●

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible
straps with a minimum of one megohm ±10% resistance in the ground cords. To provide proper
ground, wear a strap snugly against the skin at all times. On grounded mats with banana-plug
connectors, use alligator clips to connect a wrist strap.

●

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips
must be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:
●

Antistatic tape

●

Antistatic smocks, aprons, and sleeve protectors

●

Conductive bins and other assembly or soldering aids

●

Nonconductive foam

●

Conductive tabletop workstations with ground cords of one megohm resistance

●

Static-dissipative tables or floor mats with hard ties to the ground

●

Field service kits

●

Static awareness labels

●

Material-handling packages

●

Nonconductive plastic bags, tubes, or boxes

●

Metal tote boxes

●

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.
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Material

Use

Voltage protection level

Antistatic plastic

Bags

1,500 V

Carbon-loaded plastic

Floor mats

7,500 V

Metallized laminate

Floor mats

5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.
There are as many as 95 screws and screw locks, in 15 different sizes, that must be removed,
replaced, or loosened when servicing the computer. Make special note of each screw and screw lock
size and location during removal and replacement.

Service tag
When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

●

Product name (1). This is the product name affixed to the front of the computer.

●

Serial number (s/n) (2). This is an alphanumeric identifier that is unique to each product.

●

Part number/Product number (p/n) (3). This number provides specific information about the
product's hardware components. The part number helps a service technician to determine what
components and parts are needed.

●

Warranty period (4). This number describes the duration (in years) of the warranty period for the
computer.

●

Model description (5). This is the alphanumeric identifier used to locate documents, drivers, and
support for the computer.
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Computer feet
The computer feet are adhesive-backed rubber pads. There are 6 rubber feet that attach to the base
enclosure in the locations illustrated below.
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Battery
Description

Spare part number

8-cell, 73-Wh Li-ion battery

493976-001

8-cell, 68-Wh Li-ion battery

592078-001

Before disassembling the computer, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

Remove the battery:
1.

Turn the computer upside-down on a flat surface, with the battery bay toward you.

2.

Slide the battery release latch (1) to release the battery.

3.

Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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SIM
NOTE:

This section applies only to computer models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.
Before removing the SIM, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

Remove the SIM:
1.

Press in on the SIM (1). (The module is partially ejected from the SIM slot.)

2.

Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.
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Optical drive
NOTE:

All optical drive spare part kits include an optical drive bezel.

Description

Spare part number

DVD±RW and CD-RW SuperMulti DL Combo Drive with LightScribe

595759-001

Blu-ray Disc ROM with SuperMulti DVD±R/RW DL Drive

595760-001

DVD-ROM Drive

595758-001

Blu-ray ROM DVD±RW SuperMulti DL Drive

595761-001

Before removing the optical drive, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

Remove the optical drive:
1.

Position the computer with the right side toward you.

2.

Remove the Phillips PM2.5×12.0 captive screw (1) that secures the optical drive to the
computer.

3.

Push the optical drive tab (2) to release the optical drive from the computer.

4.

Remove the optical drive (3) from the computer.

5.

If it is necessary to replace the optical drive bracket, position the optical drive with the rear
toward you.
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6.

Remove the two Phillips PM2.0×3.0 screws (1) that secure the optical drive bracket to the optical
drive.

7.

Remove the optical drive bracket (2).

Reverse this procedure to install an optical drive.

Upgrade bay
Description

Spare part number

500-GB, 7200-rpm hard drive

595762-001

Before removing a drive from the upgrade bay, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

Remove the drive from the upgrade bay:
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1.

Position the computer upside down, with the front toward you.

2.

Remove the four screw covers (1) and four Phillips PM2.0×4.0 screws (2) that secure the hard
drive assembly into the upgrade bay.

3.

Loosen the captive Phillips PM2.5×12.0 screw that secures the drive in the bay (3).

4.

Push the optical drive tab (4) to release the drive from the computer.
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5.

Remove the optical drive (5) from the computer.

6.

Remove the assembly from the base enclosure.

Reverse this procedure to install the hard drive into the upgrade bay.
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Ambient light sensor
NOTE: If it has been determined that the ambient light sensor is the component that must be
replaced to complete the computer repair, the display assembly does not have to be removed. Follow
the procedures in this section to replace the ambient light sensor. For information on replacing the
display assembly and the display hinges, see Display assembly on page 82.
Description

Spare part number

Ambient light sensor board (includes cable)

595781-001

Before removing the ambient light sensor, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

Remove the ambient light sensor:
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1.

Turn the computer right-side up, with the front toward you.

2.

Open the computer as far as possible.

3.

Remove the two rubber screw covers (1) on the bottom edge of the display bezel.

4.

Remove the two Phillips PM2.5×5.0 screws (2) that secure the display bezel bottom edge to the
display assembly.

5.

Flex the inside edges of the left and right sides (1) and the display bezel bottom edge (2) until
the bezel disengages from the display assembly.
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6.

Release the display bezel bottom edge (3) from the display assembly.

7.

Remove the Phillips PM2.0×4.0 screw (1) that secures the ambient light sensor to the display
enclosure.

8.

Release the sensor (2) from the display enclosure as far as the display panel cable and
backlight cable allow.

9.

Disconnect the backlight cable (3), the display panel cable (4), and the keyboard light cable (5)
from the ambient light sensor.

10. Remove the ambient light sensor.
Reverse this procedure to install the ambient light sensor.
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Hard drive
NOTE: All hard drive spare part kits include a hard drive bracket and screws.
Description

Spare part number

640-GB, 7200-rpm hard drive

621046-001

500-GB, 7200-rpm hard drive

634919-001

320-GB, 7200-rpm hard drive, Self-encrypting drive (SED)

626978-001

320-GB, 7200-rpm hard drive

603783-001

250-GB, 7200-rpm hard drive

595753-001

256-GB solid-state drive (SSD)

595756-001

160-GB solid-state drive (SSD)

595757-001

Hard Drive Hardware Kit

630887-001

Before disassembling the computer, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

Remove the hard drive:
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1.

Position the computer upside-down, with the front toward you.

2.

Loosen the four Phillips PM2.0×7.0 captive screws (1) that secure the hard drive cover to the
computer.
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3.

Lift the right side of the hard drive cover, swing it to the left (2), and remove the cover. The hard
drive cover is included in the Plastics Kit, spare part number 595784-001

4.

Loosen the Phillips PM2.5×12.0 captive screw (1) that secures the hard drive to the computer.

5.

Grasp the Mylar tab on the hard drive and slide the hard drive to the right (2) to disconnect it
from the system board.

Component replacement procedures

55

6.

Remove the hard drive (3) from the hard drive bay.

7.

If it is necessary to replace the hard drive bracket, remove the four Phillips PM3.0×5.0 hard drive
bracket screws (1) from each side of the hard drive.

8.

Lift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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Bluetooth module
NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The
Bluetooth module cable is included in the Cable Kit, spare part number 595787-001. See Cable Kit
on page 30 for more Cable Kit spare part number information.
Description

Spare part number

Bluetooth module

537921-001

Before removing the Bluetooth module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

Remove the Bluetooth module:
1.

Position the computer upside-down, with the front toward you.

2.

Remove the Bluetooth cover by loosening the Phillips PM2.5×6.0 captive screw (1), and then
lifting the cover straight up (2) and off the computer.

3.

Remove the Bluetooth module by lifting it straight up and out of the compartment (3) as far as
the cable allows.

4.

Disconnect the Bluetooth module cable (4) from the Bluetooth module.
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Reverse this procedure to install the Bluetooth module.

RTC battery
Description

Spare part number

RTC battery

581075-001

Before removing the RTC battery, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

Remove the RTC battery:
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1.

Position the computer upside-down, with the front toward you.

2.

Loosen the two Phillips PM2.0×5.0 captive screws (1) that secure the memory module
compartment cover to the computer.

3.

Lift the right side of the cover (2), swing it up and to the left, and remove the cover. The memory
module compartment cover is included in the Plastics Kit, spare part number 595784-001.
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4.

Disconnect the RTC battery cable (1) from the system board.

5.

Gently pull the battery away from the double-sided tape that secures it to the system board and
remove it from the computer (2).

Reverse this procedure to install the RTC battery.
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Expansion memory modules
NOTE:

Expansion memory is installed in a compartment on the bottom of the computer.

Computers that use the system board with spare part number 595764-001 or 630293-001 have two
memory slots.
Computers that use the system board with spare part number 595765-001 or 630294-001 have four
memory slots. On these computers, in both the expansion memory slots (on the bottom of the
computer) and the primary memory slots (under the keyboard), slot 2 cannot be populated if slot 1 is
not populated.
Description

Spare part number

2-GB (PC3-12800, 1600-MHz, DDR3)

652972-001

4-GB (PC3-12800, 1600-MHz, DDR3)

641369-001

8-GB (PC3-10600, 1333-MHz, DDR3)

634091-001

Before removing the memory module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

Remove the expansion memory module:
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1.

Position the computer upside-down, with the front toward you.

2.

Loosen the two Phillips PM2.0×5.0 captive screws (1) that secure the memory module
compartment cover to the computer.
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3.

Lift the right side of the cover (2), swing it up and to the left, and remove the cover. The memory
module compartment cover is included in the Plastics Kit, spare part number 595784-001.

4.

Spread the retaining tabs (1) on each side of the expansion memory module slot to release the
memory module. (The edge of the module opposite the slot rises away from the computer.)

5.

Remove the expansion memory module (2) by pulling the module away from the slot at an
angle.
NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install an expansion memory module.

Component replacement procedures

61

WWAN module
CAUTION: The WWAN module and the WLAN module are not interchangeable.
NOTE:

Ericsson modules are only available in EMEA on certain computers.

Description

Spare part number

HP un2420 Broadband Module (WWAN)

531993-001

HP hs2320 HSPA Mobile Broadband Module

574248-001

HSPA F3607 WWAN minicard module

574249-001

Before removing the WWAN module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the SIM (see SIM on page 48).

Remove the WWAN module:
1.
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Loosen the captive Phillips PM2.0×5.0 captive screw (1) that secures the WWAN cover to the
computer.

Chapter 4 Removal and replacement procedures

2.

Lift the right side of the cover (2), swing it up and to the left, and remove the cover. The WWAN
cover is included in the Plastics Kit, spare part number 595784-001.

3.

Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.
NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The
blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.
There are two different WWAN modules available, and each module has the antenna connectors
reversed.

4.

Remove the two Phillips PM2.5×3.0 screws (2) that secure the WWAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)
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5.

Remove the WWAN module (3) by pulling the module away from the slot at an angle.
NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion.
Figure 4-1 Ericsson module antenna locations

Figure 4-2 Qualcomm module antenna locations

Reverse this procedure to install the WWAN module.
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Keyboard
For use in:

Spare part number

For use in:

Spare part number

Keyboards with pointing stick (includes pointing stick cable):
Belgium

595790-A41

Latin America

595790-161

Brazil

595790-201

The Netherlands and Europe

595790-B31

Bulgaria

595790-261

Norway

595790-091

Czech Republic and Slovakia

595790-A81

Portugal

595790-131

Denmark

595790-081

Russia

595790-251

France

595790-051

Saudi Arabia

595790-171

French Canada

595790-121

Slovenia

595790-BA1

Germany

595790-041

Spain

595790-071

Greece

595790-DJ1

Sweden and Finland

595790-B71

Hungary

595790-211

Switzerland

595790-BG1

Iceland

595790-DD1

Taiwan

595790-AB1

Israel

595790-BB1

Thailand

595790-281

Italy

595790-061

Turkey

595790-141

Japan

595790-291

The United Kingdom

595790-031

South Korea

595790-AD1

The United States

595790-001

Before removing the keyboard, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

Remove the keyboard:
1.

Turn the computer upside-down, with the rear toward you.
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2.

Loosen the three Phillips PM2.5×12.0 captive screws that secure the keyboard to the computer.

3.

Turn the computer right-side up, with the front toward you.

4.

Open the computer as far as possible.

5.

Slide the four keyboard retention tabs (1) toward you. The tabs are located between the esc and
f1 keys, between the f4 and f5 keys, between the f8 and f9 keys, and between the f12 and scroll
keys.

6.

Lift the rear edge of the keyboard, and then rotate the keyboard forward until it rests upsidedown on top of the TouchPad (2).

7.

Release the zero insertion force (ZIF) connector to which the keyboard cable is attached (1), and
then disconnect the keyboard cable from the system board.
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8.

Release the ZIF connector to which the pointing stick cable (2) is attached, and then disconnect
the pointing stick cable from the system board.

9.

Remove the keyboard.

Reverse this procedure to install the keyboard.
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Primary memory module
NOTE:

Primary memory is installed under the keyboard.

Computers that use the system board with spare part number 595764-001 or 630293-001 have two
memory slots.
Computers that use the system board with spare part number 595765-001 or 630294-001 have four
memory slots. On these computers, in both the expansion memory slots (on the bottom of the
computer) and the primary memory slots (under the keyboard), slot 2 cannot be populated if slot 1 is
not populated.
Description

Spare part number

2-GB (PC3-12800, 1600-MHz, DDR3)

652972-001

4-GB (PC3-12800, 1600-MHz, DDR3)

641369-001

8-GB (PC3-10600, 1333-MHz, DDR3)

634091-001

Before removing the primary memory module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 54)

b.

Keyboard (see Keyboard on page 65)

Remove the primary memory module:
1.
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Spread the retaining tabs (1) on each side of the primary memory module slot to release the
memory module. (The edge of the module opposite the slot rises away from the computer.)
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2.

Remove the primary memory module (2) by pulling the module away from the slot at an angle.
NOTE: Memory modules are designed with a notch (3) to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a primary memory module.

WLAN module
CAUTION: The WLAN module and the WWAN module are not interchangeable.
Description

Spare part number

Intel Wi-Fi Link 6300, 802.11a/b/g/n WLAN module for use in Andorra, Antigua and Barbuda,
Argentina, Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium,
Bermuda, Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands,
Chile, the People's Republic of China, Colombia, Costa Rica, Croatia, Cyprus, Czech Republic,
Denmark, Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France, French
Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam, Guatemala, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, Ivory Coast, Jamaica, Japan,
Jordan, Kenya, South Korea, Kuwait, Kyrgyzstan, Latvia, Lebanon, Martinique, US Virgin Islands,
Puerto Rico, Nether Antilles, Liechtenstein, Lithuania, Luxembourg, Malawi, Malaysia, Malta,
Mauritius, Mexico, Monaco, Montenegro, Morocco, the Netherlands, New Zealand, Nicaragua,
Nigeria, Norway, Oman, Pakistan, Panama, Paraguay, Peru, Philippines, Poland, Portugal, Qatar,
Romania, San Marino, Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa,
Spain, Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago,
Turkey, the United Arab Emirates, the United Kingdom, the United States, Uruguay, Venezuela,
and Vietnam

572511-001
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Description

Spare part number

Intel Wi-Fi Link 6200, 802.11a/b/g/n WLAN module for use in Andorra, Antigua and Barbuda,
Argentina, Aruba, Australia, Austria, Azerbaijan, Bahamas, Bahrain, Barbados, Belgium,
Bermuda, Bolivia, Bosnia and Herzegovina, Brazil, Brunei, Bulgaria, Canada, Cayman Islands,
Chile, the People's Republic of China, Colombia, Costa Rica, Croatia, Cyprus, Czech Republic,
Denmark, Dominican Republic, Ecuador, Egypt, El Salvador, Estonia, Finland, France, French
Guiana, Georgia, Germany, Ghana, Greece, Guadeloupe, Guam, Guatemala, Haiti, Honduras,
Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, Italy, Ivory Coast, Jamaica, Japan,
Jordan, Kenya, Kuwait, Kyrgyzstan, Latvia, Lebanon, Martinique, Liechtenstein, Lithuania,
Luxembourg, Malawi, Malaysia, Malta, Mauritius, Mexico, Monaco, Montenegro, Morocco, the
Nether Antilles, the Netherlands, New Zealand, Nicaragua, Nigeria, Norway, Oman, Pakistan,
Panama, Paraguay, Peru, Philippines, Poland, Portugal, Puerto Rico, Qatar, Romania, San
Marino, Saudi Arabia, Senegal, Singapore, Slovakia, Slovenia, South Africa, South Korea, Spain,
Sri Lanka, Sweden, Switzerland, Taiwan, Tanzania, Thailand, Trinidad and Tobago, Tunisia,
Turkey, the United Arab Emirates, the United Kingdom, the United States, Uruguay, the U.S.
Virgin Islands, Venezuela, and Vietnam

572509-001

Intel Wi-Fi Link 6100, 802.11a/b/g WLAN module for use in Russia and Ukraine

572510-001

Broadcom 4322 AGN 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados,
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin
Islands, and the United States

518434-001

Broadcom 4322 AGN 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria,
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan,
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda,
Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei,
Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia,
Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor,
Ecuador, Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France,
French Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada,
Guadeloupe, Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong,
Hungary, Iceland, India, Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan,
Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania,
Luxembourg, Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall
Islands, Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia,
the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia,
South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the
Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo,
Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United
Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen,
Zaire, Zambia, and Zimbabwe

518434-002

Before removing the WLAN module, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the keyboard (see Keyboard on page 65).
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Remove the WLAN module:
1.

Turn the computer right-side up, with the front toward you.

2.

Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.
NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal.
The white WLAN antenna cable is connected to the WLAN module “Aux” terminal. If the
computer is equipped with an 802.11a/b/g/n WLAN module, the yellow WLAN antenna cable is
connected to the middle terminal on the WLAN module.

3.

Remove the two Phillips PM2.0×3.0 barrel screws (2) that secure the WLAN module to the
computer. (The edge of the module opposite the slot rises away from the computer.)

4.

Remove the WLAN module (3) by pulling the module away from the slot at an angle.
NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.
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Switch cover
Description

Spare part number

Switch cover for use in model 8540p (includes LED board and cable)

595770-001

Switch cover for use in model 8540w (includes LED board and cable)

595771-001

Before removing the switch cover, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the keyboard (see Keyboard on page 65).

Remove the switch cover:
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1.

Turn the computer upside-down, with the rear toward you.

2.

Remove the three Phillips PM2.0×3.0 screws that secure the switch cover to the computer.

3.

Turn the computer right-side up, with the front toward you.

4.

Open the computer as far as possible.

5.

Disconnect the LED board cable (1) from the ZIF connector on the system board.

6.

Release the switch cover by lifting the left and right inside edges of the switch cover (2) until it
disengages from the computer, and then rotating it forward.
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7.

Remove the switch cover from the computer (3).

Reverse this procedure to install the switch cover.
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Fan
Description

Spare part number

Fan

595769-001

Before removing the fan, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the following components:
a.

Keyboard (see Keyboard on page 65)

b.

Switch cover (see Switch cover on page 72)

Remove the fan:
1.

Position the computer right-side up, with the front toward you.

2.

Disconnect the fan cable (1) from the system board.

3.

Loosen the three captive Phillips PM 2.5x5.0 screws (2) that secure the fan to the base
enclosure.
NOTE: The screw closest to the display may be hidden under display cables.
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4.

Lift the display cables aside (3) to allow room to remove the fan.

5.

Remove the Mylar (4) that secures the fan to the heat sink.
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6.

Lift the fan from the base enclosure (5).

Reverse this procedure to install the fan.
NOTE: To properly ventilate the computer, allow at least a 7.6-cm (3-in) clearance on the left side of
the computer.
The computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is
designed to turn on automatically when high temperature conditions exist. These conditions are
affected by high external temperatures, system power consumption, power management/battery
conservation configurations, battery fast charging, and software requirements. Exhaust air is
displaced through the ventilation grill located on the left side of the computer.
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Heat sink
All heat sink spare part kits include replacement thermal material.
Description

Spare part number

Heat sink for use in computers with NVIDIA Quadro FX 1800 graphics (includes fan)

595766-001

Heat sink for use in computers with NVIDIA Quadro FX 880 or NVIDIA NVS 5100 graphics (does
not include fan)

595767-001

Heat sink for use in computers with ATI FirePro M5800 graphics (includes fan)

595768-001

Before removing the heat sink, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the following components:
a.

Keyboard (see Keyboard on page 65)

b.

Switch cover (see Switch cover on page 72)

c.

Fan (see Fan on page 74)

Remove the heat sink:
1.
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Position the computer right-side up, with the front toward you.
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2.

In the order indicated, loosen the eight Torx T8M2.0x8.0 captive screws (1) - (8) that secure the
heat sink to the base enclosure.

3.

Lift the right side of the heat sink (1) to disengage it from the graphics card.

4.

Remove the heat sink (2) from the computer.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink (1) - (3)
each time the heat sink is removed. Thermal material is included with all heat sink and processor
spare part kits.
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Reverse this procedure to install the heat sink.

Processor
NOTE:

All processor spare part kits include replacement thermal material.

Description

Spare part number

Intel Core i7 processors, Quad Core
840QM, 1.86-GHz (Turbo up to 3.06) processor 8-MB L3 cache, 8 threads

612260-001

820QM, 1.73-GHz (Turbo up to 3.06) processor 8-MB L3 cache, 8 threads

583053-001

740QM, 1.73-GHz (Turbo up to 2.80) processor 6-MB L3 cache, 8 threads

612259-001

720QM, 1.60-GHz (Turbo up to 2.80) processor 6-MB L3 cache, 8 threads

586170-001

Intel Core i7 processor, Dual Core
640M, 2.80-GHz (Turbo up to 3.46) processor 4-MB L3 cache, 4 threads

625826-001

620M, 2.66-GHz (Turbo up to 3.33) processor 4-MB L3 cache, 4 threads

587259-001

Intel Core i5 processors, Dual Core
580M, 2.66-GHz (Turbo up to 3.33) processor 3-MB L3 cache, 4 threads

625825-001

560M, 2.66-GHz (Turbo up to 3.20) processor 3-MB L3 cache, 4 threads

625824-001

540M, 2.53-GHz (Turbo up to 3.06) processor 3-MB L3 cache, 4 threads

594188-001

520M, 2.40-GHz (Turbo up to 2.93) processor 3-MB L3 cache, 4 threads

594187-001

Before removing the processor, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.
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3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the following components:
a.

Keyboard (see Keyboard on page 65)

b.

Switch cover (see Switch cover on page 72)

c.

Fan (see Fan on page 74)

d.

Heat sink (see Heat sink on page 76)

Remove the processor:
1.

Position the computer right-side up, with the front toward you.

2.

Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise until you hear a click.

3.

Lift the processor (2) straight up and remove it.
NOTE: The gold triangle (3) on the processor must be aligned with the triangle (4) embossed
on the processor slot when you install the processor.

Reverse this procedure to install the processor.
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Graphics card
NOTE:

All graphics card spare part kits include replacement thermal material.

Description

Spare part number

NVIDIA NVS 5100 graphics card

595820-001

NVIDIA Quadro FX 880 graphics card

595821-001

NVIDIA Quadro FX 1800 graphics card

595822-001

ATI FirePro M5800 graphics card

595823-001

Before removing the graphics card, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the following components:
a.

Keyboard (see Keyboard on page 65)

b.

Switch cover (see Switch cover on page 72)

c.

Fan (see Fan on page 74)

d.

Heat sink (see Heat sink on page 76)

Remove the graphics card:
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1.

Position the computer right-side up, with the front toward you.

2.

Remove the two Phillips PM2.5×3.0 screws (1) that secure the graphics card to the computer.
(The edge of the board opposite the graphics card slot rises away from the computer.)
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3.

Remove the graphics card (2) by sliding it away from the graphics card slot at an angle.
NOTE: The graphics card is designed with a notch (3) to prevent incorrect insertion.

Reverse this procedure to install the graphics card.
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Display assembly
All display assemblies include 3 WLAN antenna transceivers and cables, and 2 WWAN antenna
transceivers and cables.
Description

Spare part number

For use in model 8540p:
39.6-cm (15.6-in) LED, HD, AntiGlare for use in computers without a webcam

595736-001

39.6-cm (15.6-in) LED, HD, AntiGlare for use in computers with a webcam

595737-001

39.6-cm (15.6-in) LED, FHD for use in computers without a webcam

595738-001

39.6-cm (15.6-in) LED, FHD for use in computers with a webcam

600755-001

39.6-cm (15.6-in) LED, HD+ WVA for use in computers without a webcam

595739-001

39.6-cm (15.6-in) LED, HD+ for use in computers with a webcam

595740-001

For use in model 8540w:
39.6-cm (15.6-in) LED, HD, AntiGlare for use in computers without a webcam

600756-001

39.6-cm (15.6-in) LED, HD, AntiGlare for use in computers with a webcam

600757-001

39.6-cm (15.6-in) LED, HD+ WVA for use in computers without a webcam

600760-001

39.6-cm (15.6-in) LED, HD+ WVA for use in computers with a webcam

600761-001

39.6-cm (15.6-in) LED, FHD for use in computers without a webcam

600758-001

39.6-cm (15.6-in) LED, FHD for use in computers with a webcam

600759-001

39.6-cm (15.6-in) LED, FHD, DreamColor for use in computers without a webcam

606979-001

39.6-cm (15.6-in) LED, FHD, DreamColor for use in computers with a webcam

606980-001

Before removing the display assembly, follow these steps:
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1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Disconnect the wireless antenna cables from the WLAN module (see WLAN module
on page 69) and the WWAN module (see WWAN module on page 62).

6.

Remove the following components:
a.

Keyboard (see Keyboard on page 65)

b.

Switch cover (see Switch cover on page 72)
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Remove the display assembly:
1.

Position the computer right-side up, with the front toward you.

2.

Disconnect the display panel cable (1) from the system board.

3.

Remove the display panel cable from the clips built into the top cover (2)

4.

Disconnect the microphone cable from the pass-thru cable (3).

5.

Remove the WWAN antenna cables from the channel to the bottom of the base enclosure.(4).

6.

Remove the WWAN antenna, WLAN antenna, and the microphone cables (5) from the clips built
into the top cover.

7.

Position the computer upside-down, with the rear toward you.
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8.

Remove the following:
(1) Two rubber screw covers
(2) Four Torx T8M2.5×7.0 screws, two on the bottom, two on back
(3) Two Phillips PM2.5×3.0 screws in the battery bay

9.

Remove the three Torx T8M2.5×7.0 screws (1) that secure the display assembly to the
computer.

10. Lift the display assembly (2) straight up and remove it.

CAUTION: When installing the display assembly, be sure that the 4 wireless antenna cables
routed out of the display right hinge are routed and arranged properly.
Failure to follow these routing instructions can result in degradation of the computer's WLAN and
WWAN performance.
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11. If it is necessary to replace the display bezel or display hinges, remove the following:
(1) Four rubber screw covers on the display bezel top edge
(2) Two rubber screw covers on the display bezel bottom edge
(3) Four Phillips PM2.5×5.0 screws on the display bezel top edge
(4) Two Phillips PM2.5×5.0 screws on the display bezel bottom edge
NOTE: See Ambient light sensor on page 52 for display inverter replacement instructions.

12. Flex the top (1) of the bezel, the inside edges of the left and right sides (2), and then the bottom
(3) of the bezel until it disengages from the display enclosure.
13. Remove the display bezel (4). The display bezel is available using spare part numbers
595747-001 (for use with computer models with a webcam), 595748-001 (for use with computer
models equipped without a webcam), and 595749-001 (for use with computer models equipped
with DreamColor displays).
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14. If it is necessary to replace the webcam module from the display enclosure, gently pull the
webcam module away from the double-sided tape on the display enclosure (1), disconnect the
webcam cable from the module (2), and then remove the webcam. The webcam module is
available using spare part number 583219-001.

15. If it is necessary to replace the display panel, remove the four Phillips PM2.5×5.0 screws (1) that
secure the display panel to the display enclosure.
16. Remove the display panel cable from the left hinge (2).
17. Remove the antenna and microphone cables from the right hinge (3).
18. Remove the display panel (4).
Display panels are available using spare part number 623181-001 for HD display panels and
624643-001 for the HD+ display panels.
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19. If it is necessary to remove the display panel cable, remove the tape that secures the connector
to the display panel (1), slide up and back the vertical bracket (2) that secures the cable to the
display, and then lift the cable away from the display panel (3). The display panel cable is in the
Display Panel Cable Kit, spare part number 595741-001 for HD displays and 615116-001 for
DreamColor displays.

20. If it is necessary to replace the display hinges, remove the four Phillips PM2.5×3.0 screws (1)
that secure each display hinge to the display panel.
21. Remove the display hinges (2). The left and right display hinges are available using spare part
number 595742-001 for models that do not use DreamColor displays, and 595743-001 for
models that use DreamColor displays.

Reverse this procedure to reassemble and install the display assembly.
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Top cover
All top covers include TouchPad button and bracket.
Description

Spare part number

For use with HP EliteBook 8540p computer models that include a fingerprint reader

595775-001

For use with HP EliteBook 8540p computer models that do not include a fingerprint reader

595776-001

For use with HP EliteBook 8540w computer models that include a fingerprint reader

595777-001

For use with HP EliteBook 8540w computer models that do not include a fingerprint reader

595778-001

Before removing the top cover, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 54)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 65)

d.

Switch cover (see Switch cover on page 72)

e.

Display assembly (see Display assembly on page 82)

Remove the top cover:
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1.

Turn the computer upside-down, with the front toward you.

2.

Remove the two rubber screw covers (1). The rubber screw covers are included in the Rubber
Kit, spare part number 595785-001.

3.

Remove the six Torx T8M2.5×7.0 screws (2) that secure the top cover to the base enclosure.

4.

Remove the two Phillips PM2.5x3.0 screws (3) from the optical drive bay.

Chapter 4 Removal and replacement procedures

5.

Remove the two Phillips PM2.0x3.0 screws (4) from the hard drive bay.

6.

Turn the computer right-side up, with the rear toward you.

7.

Remove the two Torx T8M2.5×6.0 screws (1) from the top of the top cover.

8.

Close the computer and turn the rear toward you.

9.

Remove the two HM2.5×6.0 screw locks (2) that secure the top cover to the computer.
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10. Disconnect the following cables from the system board:
●

(1) Black VGA cable

●

(2) Gray VGA cable

●

(3) Fingerprint reader cable

●

(4) TouchPad cable

●

(5) Card reader cable

11. Lift the rear edge of the top cover (1), and then swing it up and forward slightly.
12. Lift the top cover up (2) to allow access to the audio pass-thru cable located on the bottom of the
top cover.
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13. Disconnect the audio pass-thru cable from the system board.

Reverse this procedure to install the top cover.
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Modem module
NOTE: The modem module spare part kit does not include a modem module cable. The modem
module cable is included in the Cable Kit, spare part number 595787-001. See Cable Kit on page 30
for more Cable Kit spare part number information.
Description

Spare part number

Modem module

628824-001

Before removing the modem module, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 54)

b.

Keyboard (see Keyboard on page 65)

c.

Optical drive (see Optical drive on page 49)

d.

Switch cover (see Switch cover on page 72)

e.

Display assembly (see Display assembly on page 82)

f.

Top cover (see Top cover on page 88)

Remove the modem module:
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1.

Turn the computer right-side up, with the front toward you.

2.

Remove the Phillips PM2.0×3.0 barrel screws (1) that secure the modem module to the system
board.

3.

Disconnect the modem module (2) from the system board by lifting it straight up.
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4.

Disconnect the modem module cable (3) from the modem module.

Reverse this procedure to install the modem module.

ExpressCard/audio assembly
Description

Spare part number

ExpressCard/audio assembly

595783-001

Before removing the ExpressCard/audio assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 54)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 65)

d.

Switch cover (see Switch cover on page 72)

e.

Display assembly (see Display assembly on page 82)

f.

Top cover (see Top cover on page 88)
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g.

Fan (see Fan on page 74)

h.

Heat sink (see Heat sink on page 76)

i.

Modem module (see Modem module on page 92)

Remove the ExpressCard/audio assembly:
1.

Position the computer right-side up, with the front toward you.

2.

Disconnect the speaker cable from the assembly (1).

3.

Remove the two Torx T8M2.5×8.0 screws (2) that secure the assembly to the base enclosure.

4.

Lift the right side of the assembly (3) until the audio connectors disengage from the openings in
the base enclosure.

5.

Remove the assembly from the base enclosure.

Reverse this procedure to install the ExpressCard/audio assembly.
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Speaker assembly
Description

Spare part number

Speaker assembly

595788-001

Before removing the speaker assembly, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 54)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 65)

d.

Switch cover (see Switch cover on page 72)

e.

Display assembly (see Display assembly on page 82)

f.

Top cover (see Top cover on page 88)

Remove the speaker assembly:
1.

Position the computer right-side up, with the front toward you.
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2.

Unplug the Bluetooth cable (1) from the system board, and then remove the cable from the
routing channel atop the right speaker (2).

3.

Remove the four Phillips PM2.5×5.0 screws (1) that secure the speaker assembly to the base
enclosure.

4.

Remove the speaker assembly (2) from the base enclosure.
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Reverse this procedure to install the speaker assembly.

System board
NOTE: All system board spare part kits include replacement thermal material and VGA support
bracket.
NOTE: Models that support quad-core processors have four memory slots. Models that support
dual-core processors have two memory slots.
Description

Spare part number

For use with the following dual-core processors: 520M, 540M, 620M

595764-001

For use with the following quad-core processors: 720QM, 820QM

595765-001

For use only in Russia and the People's Republic of China with the following dual-core
processors: 520M, 540M, 620M

630293-001

For use only in Russia and the People's Republic of China with the following quad-core
processors: 720QM, 820QM

630294-001

Before removing the system board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 54)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 65)

d.

Switch cover (see Switch cover on page 72)

e.

Display assembly (see Display assembly on page 82)

f.

Fan (see Fan on page 74)

g.

Heat sink (see Heat sink on page 76)

h.

Top cover (see Top cover on page 88)

i.

ExpressCard/audio assembly (see ExpressCard/audio assembly on page 93)

j.

Modem module (see Modem module on page 92)
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When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:
●

SIM (see SIM on page 48)

●

Memory module (see Expansion memory modules on page 60)

●

WLAN module (see WLAN module on page 69)

●

WWAN module (see WWAN module on page 62)

●

Processor (see Processor on page 78)

●

Graphics card (see Graphics card on page 80)

Remove the system board:
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1.

Position the computer right-side up, with the front toward you.

2.

Remove the four Torx T8M2.5×7.0 screws (1) that secure the system board to the base
enclosure.

3.

Lift the system board up a couple of inches (2) to gain access to the VGA board connector
located under the system board.

Chapter 4 Removal and replacement procedures

4.

Disconnect the VGA board cable from the bottom of the system board.

5.

Remove the system board from the chassis.

Reverse the preceding procedure to install the system board.

RJ-11 connector cable
NOTE:

The RJ-11 connector cable is included in the Cable Kit, spare part number 595787-001.

Before removing the RJ-11 connector cable, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 54)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 65)

d.

Switch cover (see Switch cover on page 72)

e.

Display assembly (see Display assembly on page 82)

f.

Top cover (see Top cover on page 88)

g.

Fan (see Fan on page 74)
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h.

Heat sink (see Heat sink on page 76)

i.

Modem module (see Modem module on page 92)

j.

System board (see System board on page 97)

Remove the RJ-11 connector cable:
1.

Position the computer right-side up, with the front toward you.

2.

Remove the RJ-11 connector (1) from the clip built into the base enclosure.

3.

Remove the RJ-11 connector cable from the clips and routing channel (2) built into the base
enclosure.

4.

Remove the RJ-11 connector cable from the base enclosure.

Reverse this procedure to install the RJ-11 connector cable.
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USB/VGA board
Description

Spare part number

USB/VGA board (includes cable)

595782-001

Before removing the USB/VGA board, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 54)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 65)

d.

Switch cover (see Switch cover on page 72)

e.

Display assembly (see Display assembly on page 82)

f.

Top cover (see Top cover on page 88)

g.

Fan (see Fan on page 74)

h.

Heat sink (see Heat sink on page 76)

i.

Modem module (see Modem module on page 92)

j.

System board (see System board on page 97)

Remove the USB/VGA board:
1.

Position the computer right-side up, with the front toward you.

2.

Remove the Torx T8M2.5×6.0 screw (1) that secures the USB board to the base enclosure.
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3.

Lift the USB/VGA board out of the chassis (2)

Reverse this procedure to install the USB/VGA board.
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Power connector cable
NOTE:

The power connector cable is included in the Cable Kit, spare part number 595787-001.

Before removing the power connector cable, follow these steps:
1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn
the computer on, and then shut it down through the operating system.

2.

Disconnect all external devices connected to the computer.

3.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet,
and then unplugging the AC adapter from the computer.

4.

Remove the battery (see Battery on page 47).

5.

Remove the following components:
a.

Hard drive (see Hard drive on page 54)

b.

Optical drive (see Optical drive on page 49)

c.

Keyboard (see Keyboard on page 65)

d.

Switch cover (see Switch cover on page 72)

e.

Display assembly (see Display assembly on page 82)

f.

Top cover (see Top cover on page 88)

g.

Fan (see Fan on page 74)

h.

Heat sink (see Heat sink on page 76)

i.

Modem module (see Modem module on page 92)

j.

System board (see System board on page 97)

Remove the power connector cable:
1.

Position the computer right-side up, with the front toward you.

2.

Lift the power connector (1) up from the clips (2) in the rear of the base enclosure.
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3.

Remove the power connector cable from the enclosure.

Reverse this procedure to install the power connector cable.
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5

Computer Setup

Starting Computer Setup
Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating
system is not working or will not load.
NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer.
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.
To start Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2.

Press f10 to enter BIOS Setup.

Using Computer Setup
Navigating and selecting in Computer Setup
The information and settings in Computer Setup are accessed from the File, Security, Diagnostics,
and System Configuration menus.
To navigate and select in Computer Setup, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.
●

To select a menu or a menu item, use the tab key and the keyboard arrow keys, and then
press enter, or use a pointing device to click the item.

●

To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

●

To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
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NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.
2.

Press f10 to enter BIOS Setup.

3.

Select the File, Security, Diagnostics, or System Configuration menu.

To exit Computer Setup menus, choose one of the following methods:
●

To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Ignore changes and exit, and then press
enter.
– or –

●

To save your changes and exit Computer Setup menus, click the Save icon in the lower-left
corner of the screen, and then follow the on-screen instructions.
– or –
Use the tab key and the arrow keys to select File > Save changes and exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup
NOTE:

Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:
1.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

2.

Press f10 to enter BIOS Setup.

3.

Use a pointing device or the arrow keys to select File > Restore defaults.

4.

Follow the on-screen instructions.

5.

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and
then follow the on-screen instructions.
– or –
Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.
NOTE: Your password settings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus
The menu tables in this section provide an overview of Computer Setup options.
NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by
your computer.

File menu
Select

To do this

System Information

●

View identification information for the computer and the
batteries in the system.

●

View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time

Set or change the date and time on the computer.

System Diagnostics

Displays the following information:
●

System Information
◦

Identification information for the computer and the
batteries in the system.

◦

Specification information for the processor, cache
and memory size, system ROM, video revision,
and keyboard controller version.

●

Start-up Test—Verifies the system components needed
for starting the computer.

●

Run-In Test—Runs a comprehensive check on system
memory.

●

Hard Disk Test—Runs a comprehensive self-test on
any hard drive in the system.

●

Memory Test—Runs a comprehensive test on any
memory installed in the computer.

●

Battery Test—Runs a comprehensive test on any
batteries installed in the computer.

●

Error Log—Displays a log file if any errors have
occurred.

Restore defaults

Replace the configuration settings in Computer Setup with
the original factory settings. (Hard drive mode, password
settings, and security settings are not changed when you
restore the factory settings.)

Reset BIOS security to factory default

Restore the BIOS security settings to the factory default.

Ignore changes and exit

Cancel any changes entered during the current session.
Then, exit and restart the computer.

Save changes and exit

Save any changes entered during the current session. Then,
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu
NOTE:

Some of the menu items listed in this section may not be supported by your computer.

Select

To do this

Administrator Tools
Setup BIOS Administrator Password

Set up a BIOS administrator password.

User Management (requires a BIOS administrator password)
Create New BIOS User Account

●

Select from a list of BIOS users.

●

Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password)

Revise password policy criteria.

HP SpareKey

Enable/disable HP SpareKey (enabled by default).

Always Prompt for HP SpareKey Enrollment

Enable/disable HP SpareKey enrollment (enabled by
default).

Fingerprint Reset on Reboot (if present)

Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

User Tools
Change Password

Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment

Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Anti Theft
AT-p

Enable/disable Anti-Theft Protection.

DriveLock Passwords

●

Enable/disable DriveLock on any computer hard drive
(enabled by default).

●

Change a DriveLock user password or master
password.

NOTE: DriveLock settings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.
Automatic DriveLock

Enable/disable Automatic DriveLock support.

TPM Embedded Security

Enable/disable support for Trusted Platform Module (TPM)
Embedded Security, which protects the computer from
unauthorized access to owner functions available in
Embedded Security for ProtectTools. For more information,
refer to the ProtectTools software Help.
NOTE: You must have a setup password to change this
setting.

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.
CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs
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Enter a user-defined computer asset tracking number and
ownership tag.

System Configuration menu
NOTE:

Some of the listed System Configuration options may not be supported by your computer.

Select

To do this

Language

Change the Computer Setup language.

Boot Options

●

Set a Startup Menu delay (in seconds).

●

Set the Multiboot Express Boot Popup delay (in
seconds).

●

Enable/disable Custom Logo (disabled by default).

●

Enable/disable Display Diagnostic URL (enabled by
default).

●

Enable/disable CD-ROM boot (disabled by default).

●

Enable/disable SD Card boot (enabled by default).

●

Enable/disable floppy boot (enabled by default).

●

Enable/disable PXE Internal NIC boot (enabled by
default).

●

Enable/Disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

●

Set the Legacy Boot Order.

●

Enable/disable USB legacy support (enabled by
default). When enabled, USB legacy support allows the
following:

Device Configurations

◦

Use of a USB keyboard in Computer Setup even
when a Windows operating system is not running.

◦

Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

●

Select a parallel port mode: ECP (Enhanced
Capabilities Port), standard, bidirectional, or EPP
(Enhanced Parallel Port).

●

Enable/disable fan always on while connected to an AC
outlet (enabled by default).

●

Enable/disable Data Execution Prevention (select
models only). When enabled, the processor can disable
some virus code execution, which helps to improve
computer security (disabled by default).

●

SATA (Serial Advanced Technology Attachment) device
mode. The following options are available:
◦

AHCI (Advanced Host Controller Interface)

◦

IDE (Integrated Drive Electronics)

◦

RAID (Redundant Array of Independent Disks)
(select models only)

Computer Setup menus 109

Select

To do this
NOTE:
model.
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Availability of these options varies by computer

●

Enable/disable secondary battery fast charge (enabled
by default).

●

Enable/disable HP QuickLook (enabled by default).

●

Enable/disable Preboot Authentication on HP
QuickLook Boot (enabled by default).

●

Enable/disable HP QuickWeb (enabled by default).

●

Enable/disable HP QuickWeb: Write Protect (disabled
by default).

●

Enable/disable Virtualization Technology (select models
only; disabled by default).

●

Enable/disable TXT (Intel Trusted Execution
Technology) (select models only; disabled by default).

●

Multi Core CPU (enabled by default).

●

Intel HT Technology (enabled by default).

●

Enable/disable Wake on USB (enabled by default).

●

Enable/disable Num lock state at boot (disabled by
default).

Select

To do this

Built-In Device Options

●

Enable/disable the wireless button state (enabled by
default).

●

Enable/disable embedded WLAN device radio (select
models only; enabled by default).

●

Enable/disable the embedded Bluetooth device radio
(enabled by default).

●

Enable/disable the Network Interface Controller (NIC)
(enabled by default).

●

Enable/disable LAN/WLAN switching (disabled by
default).

●

Set the wake on LAN state. Options include the
following:
◦

Disabled

◦

Boot to Network

◦

Follow Boot Order

●

Enable/disable the Ambient Light Sensor.

●

Enable/disable the Notebook Upgrade Bay device
(enabled by default).

●

Enable/disable the fingerprint device (enabled by
default).

●

Enable/disable the integrated camera (enabled by
default).

●

Enable/disable the Power Monitor Circuit (enabled by
default).

●

Enable/disable the audio device (enabled by default).

●

Enable/disable a modem device (enabled by default).

●

Enable/disable the microphone (enabled by default).

●

Enable/disable the internal speakers (enabled by
default).
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Select

To do this

Port Options

NOTE:

All port options are enabled by default.

●

Enable/disable the serial port.

●

Enable/disable the parallel port.

●

Enable/disable the flash media reader.

●

Enable/disable the USB port.
CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

AMT Options

●

Enable/disable the 1394 port.

●

Enable/disable the ExpressCard slot.

●

Enable/disable the Smart Card slot.

●

Enable/disable the eSATA port.

●

Enable/disable Firmware Verbosity.

●

Enable/disable AMT Setup Prompt (Ctrl+P).

●

Enable/disable USB Key Provisioning Support.

●

Enable/disable Unconfigure AMT on next boot.

●

Select Terminal Emulation Mode.
◦

ANSI

◦

VT100

●

Enable/disable Firmware Progress Event Support.

●

Enable/disable Initiate Intel CIRA.

Set Security Level

Change, view, or hide security levels for all BIOS menu
items.

Restore Security Defaults

Restore the default security settings.
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Specifications

Computer specifications
Metric

U.S.

Length

25.2 cm

9.9 in

Width

37.4 cm

14.7 in

Height (front to rear)

3.2 to 3.7 cm

1.28 to 1.45 in

Weight (equipped with 39.6-cm (15.6-in) HD+ display, NV
Graphics, DVD drive, 1-GB DIMM, 160-GB hard drive,
WLAN module, 8-cell battery)

2.89 kg

6.37 lbs

Dimensions

Input power
Operating voltage

19.0 V dc @ 4.74 A – 90 W

Operating current

4.74 A

Temperature
Operating (not writing to optical disc)

0°C to 35°C

32°F to 95°F

Operating (writing to optical disc)

5°C to 35°C

41°F to 95°F

Nonoperating

-20°C to 60°C

-4°F to 140°F

Relative humidity
Operating

10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)
Operating (14.7 to 10.1 psia)

-15 m to 3,048 m

50 ft to 10,000 ft

Nonoperating (14.7 to 4.4 psia)

-15 m to 12,192 m

-50 ft to 40,000 ft

Shock
Operating

125 g, 2 ms, half-sine

Nonoperating

200 g, 2 ms, half-sine

Random vibration
Operating

0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep
rate
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Metric
Nonoperating

U.S.

1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within
this range of temperatures.

39.6-cm (15.6-in) HD display specifications
Metric

U.S.

Height

21.0 cm

8.25 in

Width

35.9 cm

14.15 in

Diagonal

39.6 cm

15.6 in

Surface treatment

Anti-glare

Contrast ratio

300:1 (typical)

Refresh rate

60 Hz

Brightness

200 nits (typical)

Dimensions

Pixel resolution
Pitch

0.252 mm

Format

1366 × 768

Configuration

RGB stripe

Backlight

LED

PPI

101 ppi

Viewing angle

+/-30 horizontal (minimum), +/–10° vertical (minimum)
30/30/20/10 (Left/Right/Down/Up) (minimum) or
45/45/35/25 (Left/Right/Down/Up) (typical)
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39.6-cm (15.6-in) HD+ display specifications
Metric

U.S.

Height

20.9 cm

8.25 in

Width

35.9 cm

14.15 in

Diagonal

39.6 cm

15.6 in

Surface treatment

Anti-glare

Contrast ratio

300:1 (typical)

Refresh rate

60 Hz

Brightness

200 nits (typical)

Dimensions

Pixel resolution
Pitch

0.2151 mm

Format

1600 × 900

Configuration

RGB stripe

Backlight

LED

PPI

118 ppi

Viewing angle

30/30/20/10 (Left/Right/Down/Up) (minimum) or
45/45/35/25 (Left/Right/Down/Up) (typical)
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39.6-cm (15.6-in) FHD display specifications
Metric

U.S.

Height

20.9 cm

8.25 in

Width

35.9 cm

14.15 in

Diagonal

39.6 cm

15.6 in

Surface treatment

Anti-glare

Contrast ratio

300:1 (typical)

Refresh rate

60 Hz

Brightness

220 nits (typical)

Dimensions

Pixel resolution
Pitch

0.179 × 0.179 mm

Format

1920 × 1080

Configuration

RGB stripe

Backlight

LED

PPI

142 ppi

Viewing angle

60/60/50/50 (Left/Right/Down/Up) (minimum) or
70/70/60/60 (Left/Right/Down/Up) (typical)
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Hard drive specifications
640-GB*

500-GB*

320-GB*

250-GB*

Height

9.5 mm

9.5 mm

9.5 mm

9.5 mm

Width

70 mm

70 mm

70 mm

70 mm

Weight

101 g

101 g

101 g

101 g

Interface type

SATA

SATA

SATA

SATA

Transfer rate

100 MB/sec

100 MB/sec

100 MB/sec

100 MB/sec

Security

ATA security

ATA security

ATA security

ATA security

Dimensions

Seek times (typical read, including setting)
Single track

2 ms

3 ms

3 ms

3 ms

Average

12 ms

13 ms

13 ms

13 ms

Maximum

22 ms

24 ms

24 ms

24 ms

Logical blocks

1,250,263,728

1,048,576,000

625,141,400

488,397,168

Disc rotational speed

7200 rpm

7200 rpm

7200 rpm

7200 rpm

Operating temperature

5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive
specifications may differ slightly.
NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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DVD±RW and CD-RW SuperMulti DL Combo Drive
specifications
Applicable disc

Center hole diameter

Read:

Write:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CDROM, CD-ROM XA, MIXED MODE CD, CD-I,
CD-I Bridge (Photo-CD, Video CD),
Multisession CD (Photo-CD, CD-EXTRA,
Portfolio, CD-R, CD-RW), CD-R, CD-RW, DVDROM (DVD-5, DVD-9, DVD-10, DVD-18), DVDR, DVD-RW, DVD+R, DVD+RW, DVD-RAM

CD-R and CD-RW
DVD+R, DVD+RW, DVD-R, DVDRW, DVD-RAM

1.5 cm (0.59 in)

Disc diameter
Standard disc

12 cm (4.72 in)

Mini disc

8 cm (3.15 in)

Disc thickness

1.2 mm (0.047 in)

Track pitch

0.74 µm

Access time

CD

DVD

Random

< 175 ms

< 230 ms

Full stroke

< 285 ms

< 335 ms

Audio output level

Line-out, 0.7 Vrms

Cache buffer

2 MB

Data transfer rate
24X CD-ROM

3,600 KB/sec

8X DVD-ROM

10,800 KB/sec

24X CD-R

3,600 KB/sec

16X CD-RW

2,400 KB/sec

8X DVD+R

10,800 KB/sec

4X DVD+RW

5,400 KB/sec

8X DVD-R

10,800 KB/sec

4X DVD-RW

5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec

5X DVD-RAM

6,750 KB/sec

Transfer mode

Multiword DMA Mode

Startup time

< 15 seconds

Stop time

< 6 seconds
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Blu-ray Disc ROM with SuperMulti DVD±R/RW DL Drive
Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD-MIDI, CDTEXT,
CD-ROM, CD-ROM XA,
MIXED MODE CD, CD-I, CD-I Bridge
(Photo-CD, Video CD), Multisession
CD (Photo-CD, CD-EXTRA, Portfolio,
CD-R, CD-RW), CD-R, CD-RW,
DVDROM (DVD-5, DVD-9, DVD-10,
DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM, HDROM (Single Layer), HD-ROM (Dual
Layer), HD DVD-R, HD DVD-R for
Dual Layer, HD DVD-RW

CD-R and CD-RW DVD+R, DVD+R(9),
DVD+RW, DVD-R, DVD-R(9),DVD-RW,
DVD-RAM

Access time

CD

DVD

HD

Random

170 ms

170 ms

230 ms

Cache buffer

8 MB

Data transfer rate
24X CD-ROM

3,600 KB/sec

8X DVD

10,800 KB/sec

24X CD-R

3,600 KB/sec

16X CD-RW

2,400 KB/sec

8X DVD+R

10,800 KB/sec

4X DVD+RW

5,400 KB/sec

8X DVD-R

10,800 KB/sec

4X DVD-RW

5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec

5X DVD-RAM

6,750 KB/sec

1X BD-ROM

4,500 KB/sec

1X BD-R read

4,500 KB/sec

1X BD-RE read

4,500 KB/sec

Transfer mode

Multiword DMA Mode
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Blu-ray Disc ROM Combo Drive
Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA, MIXED MODE
CD, CD-I, CD-I Bridge (Photo-CD,
Video CD), Multisession CD (PhotoCD, CD-EXTRA, Portfolio, CD-R, CDRW), CD-R, CD-RW, DVD-ROM
(DVD-5, DVD-9, DVD-10, DVD-18),
DVD-R, DVD-RW, DVD+R, DVD+RW.
DVD-RAM, BD-ROM, BD-R, BD-RE

CD-R, CD-RW, DVD+R, DVD+R(9),
DVD+RW, DVD-R, DVD-R(9), DVD-RW,
DVD-RAM

Access time

CD

DVD

BD-ROM

Random

<190 ms

<190 ms

<230 ms

Maximum Media Capacity (read)

50 GB

Maximum Media Capacity (write)

8.5 GB

Data transfer rate
24X CD-ROM

3,600 KB/sec

8X DVD

10,800 KB/sec

16X CD-R

2,400 KB/sec

10X CD-RW

1.500 KB/sec

8X DVD+R

10,800 KB/sec

8X DVD+RW

10,800 KB/sec

8X DVD-R

10,800 KB/sec

6X DVD-RW

8,100 KB/sec

4X DVD+R Dual Layer

5,400 KB/sec

4X DVD-R Dual Layer

5,400 KB/sec

5X DVD-RAM

6,750 KB/sec

2X BD-ROM

9,000 KB/sec
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DVD-ROM Drive specifications
Applicable disc

DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital
Audio, CD-XA ready (Mode 2, Form 1 and Form 2), CD-I (Mode 2, Form 1 and Form
2), CD-R, CD-RW, Photo CD (single and multisession), CD-Bridge

Center hole diameter

1.5 cm (0.59 in)

Disc diameter
Standard disc

12 cm (4.72 in)

Mini disc

8 cm (3.15 in)

Disc thickness

1.2 mm (0.047 in)

Track pitch

0.74 µm

Access time

CD

DVD

Random

< 100 ms

< 125 ms

Full stroke

< 175 ms

< 225 ms

Audio output level

Line-out, 0.7 Vrms

Cache buffer

512 KB

Data transfer rate
CD-R (24X)

3600 KB/s (150 KB/s at 1X CD rate)

CD-RW (10X)

1500 KB/s (150 KB/s at 1X CD rate)

CD-ROM (24X)

3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X)

10,800 KB/s (1,352 KB/s at 1X DVD rate)

Multiword DMA mode 2

16.6 MB/s

Startup time

< 10 seconds

Stop time

< 3 seconds
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Specification information in Device Manager
Device Manager allows you to view and control the hardware attached to the computer, as well as
provides hardware specification information.
You can also add hardware or modify device configurations using Device Manager.
NOTE: Windows 7 and Windows Vista include the User Account Control feature to improve the
security of your computer. You may be prompted for your permission or password for tasks such as
installing software, running utilities, or changing Windows settings. Refer to Windows Help and
Support for more information.
After you open Device Manager, drill-down to a device and double-click it to access its properties.
To access Device Manager in Windows 7:
1.

Select Start > Computer > System properties.

2.

In the left pane, click Device Manager.

To access Device Manager in Windows Vista:
1.

Select Start > Computer > System properties.

2.

In the left pane, click Device Manager.

To access Device Manager in Windows XP:
1.

Select Start > My Computer.

2.

In the left pane of the System Tasks window, select View system information.

3.

Select Hardware tab > Device Manager.
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7

Backup and recovery

Windows 7
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only),
or create system restore points. In case of system failure, you can use the backup files to restore the
contents of your computer.
Windows Backup and Restore provides the following options:
●

Creating a system repair disc (select models only)

●

Backing up individual files and folders

●

Creating a system image (select models only)

●

Scheduling automatic backups (select models only)

●

Creating system restore points

●

Recovering individual files

●

Restoring the computer to a previous state

●

Recovering information using recovery tools

NOTE:

For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create
system repair discs (select models only) and your initial backup immediately after software setup. As
you add new software and data files, you should continue to back up your system on a regular basis
to maintain a reasonably current backup. The system repair discs (select models only) are used to
start up (boot) the computer and repair the operating system in case of system instability or failure.
Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.
You can back up your information to an optional external hard drive, a network drive, or discs.
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Note the following when backing up:
●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
To create a screen shot:
1.

Display the screen you want to save.

2.

Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3.

Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4.
●

Save the document.

When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive installed in your computer.
NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

●

When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore, follow these steps:
NOTE:

Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).
NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support
for more information.
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Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

●

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
discs you previously created (select models only), you must purchase a Windows 7 operating system
DVD to reboot the computer and repair the operating system. For additional information, refer to the
“Using a Windows 7 operating system DVD (purchased separately)” section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1.

Select Start > All Programs > Maintenance > Backup and Restore.

2.

Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support for
more information.
To recover your information using Startup Repair, follow these steps:
CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the Windows partition and the HP Recovery partition.
To check for the Windows partition, select Start > Computer.
To check for the HP Recovery partition, select Start, right-click Computer, click Manage, and
then click Disk Management.
NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 7 operating system DVD and the Driver
Recovery disc (both purchased separately). For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section in this guide.

3.

If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press f8 before the Windows operating system loads.

4.

Select Startup Repair.

5.

Follow the on-screen instructions.
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NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.
To recover the original hard drive image using f11, follow these steps:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: select Start, right-click
Computer, click Manage, and then click Disk Management.
NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows 7 operating
system DVD (purchased separately)” section in this guide.

3.

If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press
the ESC key for Startup Menu” message is displayed at the bottom of the screen.

4.

Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5.

Follow the on-screen instructions.

Using a Windows 7 operating system DVD (purchased separately)
If you are unable to boot (start up) your computer and you cannot use the system repair discs you
previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. Make sure that your most recent backup
(stored on discs or on an external drive) is easily accessible. To order a Windows 7 operating system
DVD, go to http://www.hp.com/support, select your country or region, and then follow the on-screen
instructions. You can also order the DVD by calling technical support. For contact information, refer to
the Worldwide Telephone Numbers booklet included with the computer.
CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows 7 operating system DVD, follow these steps:
NOTE:

This process takes several minutes.

1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows 7 operating system DVD into the optical
drive before the Windows operating system loads.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

5.

Click Next.
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6.

Select Repair your computer.

7.

Follow the on-screen instructions.
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Windows Vista
To protect your information, use the Backup and Restore Center to back up individual files and
folders, back up your entire hard drive (select models only), or create system restore points. In case
of system failure, you can use the backup files to restore the contents of your computer.
The Backup and Restore Center provides the following options:
●

Backing up individual files and folders

●

Backing up the entire hard drive (select models only)

●

Scheduling automatic backups (select models only)

●

Creating system restore points

●

Recovering individual files

●

Restoring the computer to a previous state

●

Recovering information using recovery tools

NOTE:

For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.
You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:
●

Store personal files in the Documents folder, and back it up regularly.

●

Back up templates that are stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
To create a screen shot:
1.

Display the screen you want to save.

2.

Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3.

Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4.

Save the document.
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●

When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend
on the type of optical drive installed in your computer.
NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

●

When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore Center, follow these steps:
NOTE:

Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.
1.

Select Start > All Programs > Maintenance > Backup and Restore Center.

2.

Follow the on-screen instructions to back up your entire computer (select models only) or your
files.
NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support
for more information.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use the Backup and Restore Center to recover information
you have previously backed up. You can also use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly.

●

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the
factory.

NOTE: If you are unable to boot (start up) your computer, you must purchase a Windows Vista®
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)”
section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1.

Select Start > All Programs > Maintenance > Backup and Restore Center.

2.

Follow the on-screen instructions to recover your entire computer (select models only) or your
files.

NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Windows Help and Support for
more information.
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To recover your information using Startup Repair, follow these steps:
CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently
removed. When reformatting is complete, the recovery process restores the operating system, as well
as the drivers, software, and utilities from the backup used for recovery.
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the Windows partition and the HP Recovery partition. To
find the partitions, select Start > Computer.
NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD
and the Driver Recovery disc (both purchased separately). For additional information, refer to
the “Using a Windows Vista operating system DVD (purchased separately)” section in this guide.

3.

Restart the computer, and then press f8 before the Windows operating system loads.

4.

Select Repair your computer.

5.

Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The f11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.
To recover the original hard drive image using f11, follow these steps:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition. To find the partition, select
Start > Computer.
NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc
(both purchased separately). For additional information, refer to the “Using a Windows Vista
operating system DVD (purchased separately)” section in this guide.

3.

Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup
Menu” message is displayed at the bottom of the screen.

4.

Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5.

Follow the on-screen instructions.

Using a Windows Vista operating system DVD (purchased separately)
If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating
system DVD to reboot the computer and repair the operating system. Make sure that your most
recent backup (stored on discs or on an external drive) is easily accessible. To order a Windows Vista
operating system DVD, go to http://www.hp.com/support, select your country or region, and then
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follow the on-screen instructions. You can also order the DVD by calling technical support. For
contact information, refer to the Worldwide Telephone Numbers booklet included with the computer.
CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents
and reformats the hard drive. All files you have created and any software installed on the computer
are permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.
To initiate recovery using a Windows Vista operating system DVD, follow these steps:
NOTE:

This process takes several minutes.

1.

If possible, back up all personal files.

2.

Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

5.

Click Next.

6.

Select Repair your computer.

7.

Follow the on-screen instructions.
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Windows XP
To protect your information, use the Windows Backup utility (select models only) to back up files and
folders or create recovery points. In case of system failure, you can use the backup files to restore
your computer.
Windows provides the following options:
●

Backing up individual files and folders

●

Backing up all files and folders

●

Scheduling automatic backups

●

Creating recovery points

●

Recovering information

NOTE:

For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and
save them for later use.

Backing up your information
Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.
You can back up individual files or folders to an optional external hard drive or to a network drive.
Note the following when backing up:
●

Store personal files in the My Documents folder, and back it up periodically.

●

Back up templates stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.
To copy the screen and paste it into a word-processing document:
a.

Display the screen you want to save.

b.

Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

c.

Open a word-processing document, click Edit > Paste.
The screen image is added to the document.

d.

Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:
NOTE:

Be sure that the computer is connected to AC power before you start the backup process.
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NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.
1.

Select Start > All Programs > Accessories > System Tools > Backup.

2.

Follow the on-screen instructions.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

●

Operating System and Driver Recovery discs (included with your computer): You can use the
discs to recover your operating system and programs installed at the factory.

Recovering your information
To recover information you previously backed up, follow these steps:
1.

If possible, back up all personal files.

2.

Select Start > All Programs > Accessories > System Tools > Backup.
The Backup or Restore Wizard opens.

3.

Click Restore files and settings, and then click Next.

4.

Follow the on-screen instructions.

NOTE: For additional information on initiating a recovery in Windows, perform a search for this topic
in Help and Support.

Recovering the operating system and programs
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system, software, and drivers. Software, drivers, and updates not
installed by HP must be manually reinstalled.
To recover your operating system and programs, follow these steps:
1.

If possible, back up all personal files.

2.

Insert the Operating System disc into the optical drive.

3.

Shut down the computer.

4.

Turn on the computer.

5.

Follow the on-screen instructions to install the operating system.

6.

After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

7.

Follow the on-screen instructions to install the drivers and programs.
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8

Connector pin assignments

Audio-out (headphone)

Pin

Signal

1

Audio out, left channel

2

Audio out, right channel

3

Ground

Audio-in (microphone)

Pin

Signal

1

Audio signal in

2

Audio signal in

3

Ground
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External monitor

Pin

Signal

1

Red analog

2

Green analog

3

Blue analog

4

Not connected

5

Ground

6

Ground analog

7

Ground analog

8

Ground analog

9

+5 VDC

10

Ground

11

Monitor detect

12

DDC 2B data

13

Horizontal sync

14

Vertical sync

15

DDC 2B clock
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RJ-11 (modem)

Pin

Signal

1

Unused

2

Tip

3

Ring

4

Unused

5

Unused

6

Unused

RJ-45 (network)

Pin

Signal

1

Transmit +

2

Transmit -

3

Receive +

4

Unused

5

Unused

6

Receive -

7

Unused

8

Unused

136 Chapter 8 Connector pin assignments

Universal Serial Bus

Pin

Signal

1

+5 VDC

2

Data -

3

Data +

4

Ground
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9

Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.
The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.
Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions
The requirements listed below are applicable to all countries and regions:
●

The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

●

All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

●

The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

●

The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions
Country/region

Accredited agency

Applicable note number

Australia

EANSW

1

Austria

OVE

1

Belgium

CEBC

1

Canada

CSA

2

Denmark

DEMKO

1

Finland

FIMKO

1

France

UTE

1

Germany

VDE

1

Italy

IMQ

1

Japan

METI

3

The Netherlands

KEMA

1

Norway

NEMKO

1

The People's Republic of China

CCC

5

South Korea

EK

4

Sweden

SEMKO

1

Switzerland

SEV

1

Taiwan

BSMI

4

The United Kingdom

BSI

1

The United States

UL

2

1.

The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region
where it will be used.

2.

The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3.

The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall
plug must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4.

The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5.

The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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10 Recycling

Battery
When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.
CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the LCD panel and the backlight. When you remove
these components, handle them carefully.
NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.
This section provides disassembly instructions for the display assembly. The display assembly must
be disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

NOTE: The procedures provided in this chapter are general disassembly instructions. Specific
details, such as screw sizes, quantities, and locations, and component shapes and sizes, can vary
from one computer model to another.

140 Chapter 10 Recycling

Perform the following steps to disassemble the display assembly:
1.

Remove all screw covers (1) and screws (2) that secure the display bezel to the display
assembly.

2.

Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3.

Remove the display bezel (3).
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4.

Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5.

Remove all screws (1) that secure the display panel assembly to the display enclosure.

6.

Remove the display panel assembly (2) from the display enclosure.

7.

Turn the display panel assembly upside-down.

8.

Remove all screws that secure the display panel frame to the display panel.

9.

Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the
display panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.
12. Lift the top edge of the backlight cover (2) and swing it outward.

13. Remove the backlight cover.
14. Turn the display panel right-side up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside-down.
WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.
17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.
21. Release the LCD panel (3) from the display rear panel.
22. Release the tape (4) that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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Symbols/Numerics
1394 port, identifying

17

A
AC adapter, spare part numbers
32, 33, 38
ambient light sensor
identifying 9
removal 52
spare part number 37, 52
AMT options 112
AMT Setup Prompt (Ctrl-P)
112
Firmware Progress Event
Support 112
Firmware Verbosity 112
Initiate Intel CIRA 112
Terminal Emulation Mode 112
Unconfigure AMT on next
boot 112
USB Key Provisioning
Support 112
antennas 20
disconnecting 63, 71
WLAN 20
WWAN 20
Anti Theft 108
applications key, Windows 15
audio, product description 3
audio-in (microphone) jack
identifying 17
pin assignments 134
audio-out (headphone) jack
identifying 17
pin assignments 134
B
backing up files 123
Backup and Restore 123, 124
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Backup and Restore Center 128,
129
base enclosure, spare part
number 27, 36
battery
removal 47
spare part number 27, 47
battery bay 19
battery latch kit, spare part
number 36
battery light 16
battery release latch 19
bays, hard drive 19
BIOS administrator password
108
Blu-ray Disc ROM Drive,
specifications 120
Blu-ray Disc ROM with SuperMulti
DVD±R/RW DL Drive
removal 49
spare part number 27, 31, 36,
49
specifications 119
Blu-ray ROM DVD±RW SuperMulti
DL Drive, spare part number
27, 31, 36, 49
Bluetooth cable, illustrated 30
Bluetooth module
removal 57
spare part number 34
spare part numbers 27, 57
Bluetooth module cover,
illustrated 29
boot options 109
boot order 109
built-in device
Ambient Light Sensor 111
audio device 111
Bluetooth device radio 111

fingerprint reader 111
integrated camera 111
internal speakers 111
LAN/WLAN switching 111
microphone 111
modem 111
Network Interface Controller
(LAN) 111
Notebook Upgrade Bay 111
Power Monitor Circuit 111
Wake on LAN 111
wireless button 111
WLAN device radio 111
built-in device options 111
business card slot, identifying 17
buttons
display release 17
mute 14
pointing stick 10
power 13
QuickLook 13
QuickWeb 14
TouchPad 10, 14
volume 14
Wireless 14
C
Cable Kit
contents 30
spare part number 27, 30, 37
cables, service considerations 41
caps lock light, identifying 12
chipset, product description 1
components
bottom 19
display 9
front 16
left-side 17
rear 18

right-side 18
top 10
computer feet
locations 46
spare part number 46
Computer Setup
File menu 107
navigating and selecting 105
restoring factory settings 106
Security menu 108
System Configuration menu
109
computer specifications 113
connector, power 18
connectors, service
considerations 41
creating a backup 123
D
device configurations 109
discs
Driver Recovery 133
Operating System 133
disk sanitizer 108
diskette drive
precautions 41
product description 3
display assembly
removal 82
spare part numbers 22, 35, 82
display bezel
release 52
removal 85
spare part numbers 28, 36, 85
display component recycling 140
display components, spare part
numbers 28
display hinge
removal 87
spare part number 28, 35, 87
display panel
product description 2
removal 86
display release button,
identifying 17
display specifications 114, 115,
116
DisplayPort, identifying 17
docking support, product
description 5

drive light 16
DriveLock password 108
DriveLock, automatic 108
Driver Recovery disc 133
drives
boot order 109
preventing damage 41
DVD-ROM Drive
precautions 41
removal 49
spare part number 27, 31, 36,
49
specifications 121
DVD±RW and CD-RW SuperMulti
DL Combo Drive with LightScribe
precautions 41
removal 49
spare part number 27, 31, 36,
49
E
electrostatic discharge 42
eSata port, identifying 17
esc key, identifying 15
Ethernet, product description 4
Execution Disable 109
expansion memory module
removal 60
spare part numbers 60
ExpressCard slot insert,
illustrated 29
ExpressCard slot, identifying 17
ExpressCard/audio assembly
removal 93
spare part number 26, 37, 93
external media cards, product
description 4
external monitor port
identifying 18
pin assignments 135
F
f11 recovery 126, 130
fan
removal 74
spare part number 24, 36, 74
feet
illustrated 29
locations 46
spare part number 46

File menu 107
fingerprint reader board, spare part
number 24, 36
fingerprint reader, identifying 14
fn key, identifying 15
function keys, identifying 15
G
graphics card
removal 80
spare part numbers 26, 38, 80
graphics, product description 1
grounding equipment and
methods 44
H
hard drive
precautions 41
product description 3
removal 54
spare part numbers 27, 31,
36, 38, 39, 54
specifications 117
hard drive bay 19
hard drive bracket, removal 56
hard drive cover
illustrated 29
removal 55
hard drive recovery 126, 130
headphone (audio-out) jack
identifying 17
pin assignments 134
heat sink
removal 76
spare part number 24, 36, 76
hinge
removal 87
spare part number 28, 35, 87
HP QuickLook 110
HP SpareKey enrollment 108
I
IEEE 1394 port, identifying 17
Intel HT Technology 110
internal display switch,
identifying 9
internal microphone, identifying 9
J
jacks
audio-in (microphone) 17
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audio-out (headphone) 17
RJ-11 (modem) 18
RJ-45 (network) 18
K
keyboard
product description 5
removal 65
spare part numbers 23, 37, 65
keyboard light, identifying 9
keypad keys, identifying 15
keys
esc 15
fn 15
function 15
keypad 15
Windows applications 15
Windows logo 15
L
language, changing in Computer
Setup 109
latch, battery release 19
legacy support, USB 105, 109
lights
battery 16
caps lock 12
drive 16
keyboard 9
local area network (LAN) 16
mute 12
num lock 12
power 11, 16
QuickLook 12
QuickWeb 12
TouchPad 12
volume down 12
volume mute 12
volume up 12
webcam 9
wireless 11, 16
M
mass storage devices, spare part
numbers 31
Media Card Reader, identifying
16
memory module
product description 2
removal 60, 68
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spare part number 68
spare part numbers 27, 60
memory module compartment
cover
illustrated 29
removal 58, 60
microphone (audio-in) jack
identifying 17
pin assignments 134
product description 3
model name 1
modem jack, pin assignments
136
modem module
product description 4
removal 92
spare part number 25, 39, 92
monitor port
external 18
pin assignments 135
Multi Core CPU 110
mute button, identifying 14
mute light, identifying 12
N
network jack, pin assignments
136
num lock light, identifying 12
O
Operating System disc 133
operating system, product
description 6
optical drive
precautions 41
product description 3
removal 49
spare part numbers 27, 31, 49
specifications 118, 119, 120,
121
P
packing guidelines 43
parallel port mode 109
passwords 108
pin assignments
audio-in jack 134
audio-out jack 134
external monitor port 135
headphone jack 134
microphone jack 134

modem jack 136
monitor port 135
network jack 136
RJ-11 136
RJ-45 jack 136
Universal Serial Bus (USB)
port 137
plastic parts 40
Plastics Kit
contents 29
spare part number 29, 37
pointing device, product
description 5
pointing stick buttons, identifying
10
pointing stick, identifying 10
port options 112
1394 port 112
eSATA port 112
ExpressCard slot 112
flash media reader 112
parallel port 112
serial port 112
Smart Card slot 112
USB port 112
ports
1394 17
DisplayPort 17
eSATA 17
external monitor 18
product description 5
USB 17, 18
power button, identifying 13
power connector cable
removal 103
spare part numbers 103
power connector cable,
illustrated 30
power connector, identifying 18
power cord
set requirements 138
spare part numbers 32, 33
power lights, identifying 11, 16
power requirements, product
description 5
primary memory module
removal 68
spare part number 68
processor
product description 1

removal 78
spare part numbers 24, 78
product description
audio 3
chipset 1
diskette drive 3
display panel 2
docking support 5
Ethernet 4
external media cards 4
graphics 1
hard drives 3
keyboard 5
memory module 2
microphone 3
modem module 4
operating system 6
optical drives 3
pointing devices 5
ports 5
power requirements 5
processors 1
product name 1
security 6
serviceability 8
webcam 4
wireless 4
product name 1
Q
QuickLook button, identifying 13
QuickLook light, identifying 12
QuickWeb button, identifying 14
QuickWeb light, identifying 12
R
recovery partition 126, 130
release latch, battery 19
removal/replacement
preliminaries 40
procedures 45
restore security defaults 112
restore the factory settings 107
restoring
hard drive 126, 130
RJ-11 (modem) jack
identifying 18
pin assignments 136

RJ-11 connector cable
illustrated 30
removal 99
RJ-45 (network) jack
identifying 18
pin assignments 136
RTC battery
removal 58
spare part number 26, 35, 58
Rubber Kit, spare part number 37
S
SATA (Serial Advanced
Technology Attachment)
devices 109
AHCI (Advanced Host
Controller Interface) 109
IDE (Integrated Drive
Electronics) 109
Screw Kit, spare part number 33,
37
scroll zone, TouchPad 10
Secondary Battery Fast Charge
110
security cable slot, identifying 18
Security menu 108
always prompt for HP
SpareKey enrollment 108
Automatic DriveLock 108
change password 108
Disk Sanitizer 108
DriveLock 108
fingerprint reader reset 108
HP Sparekey 108
HP Sparekey enrollment 108
password policy 108
set up BIOS administrator
password 108
System IDs 108
security, product description 6
service considerations 40
service tag 21, 45
serviceability, product
description 8
set security level 112
setup utility
File menu 107
navigating and selecting 105
restoring factory settings 106

Security menu 108
System Configuration menu
109
SIM, removal 48
slots
business card 17
ExpressCard 17
security cable 18
smart card reader 18
smart card reader, identifying 18
solid-state drive, spare part
numbers 27, 31, 36, 54
speaker assembly
identifying 16
removal 95
spare part number 26, 37, 95
specifications
Blu-ray Disc ROM Drive 120
Blu-ray Disc ROM with
SuperMulti DVD±R/RW DL
Drive 119
computer 113
display 114, 115, 116
DVD-ROM Drive 121
DVD±RW and CD-RW
SuperMulti DL Combo
Drive 118
hard drive 117
optical drive 118, 119, 120,
121
static-shielding materials 44
switch cover
removal 72
spare part number 23, 36, 72
system board
removal 97
spare part number 26
spare part numbers 36, 97
System Configuration menu 109
system date and time 107
system diagnostics 107
system fan 109
system IDs 108
system information 107
T
thermal material, replacement 77
tools required 40
top cover
removal 88
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spare part number 24, 88
spare part numbers 36
TouchPad buttons, identifying
10, 14
TouchPad cable, illustrated 30
TouchPad light, identifying 12
TouchPad scroll zone,
identifying 10
TouchPad, identifying 10
TPM Embedded Security 108
transporting guidelines 43
TXT (Intel Trusted Execution
Technology) 110
U
Unified Extensible Firmware
Interface (UEFI) mode 109
Universal Serial Bus (USB) port,
pin assignments 137
upgrade bay
identifying 18
removal 50
spare part number 50
USB legacy support 105, 109
USB ports, identifying 17, 18
USB/VGA board
removal 101
spare part number 26, 101
spare part numbers 37
User management 108
V
vents, identifying 17, 19
Virtualization Technology 110
volume down button, identifying
14
volume down light, identifying 12
volume mute button, identifying
14
volume mute light, identifying 12
volume up button, identifying 14
volume up light, identifying 12
W
webcam
identifying 9
product description 4
spare part number 35
webcam light, identifying 9
Windows 7 operating system
DVD 126
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Windows applications key,
identifying 15
Windows Backup utility 132, 133
Windows logo key, identifying 15
Windows recovery 133
Windows Vista operating system
DVD 130
wireless antennas
disconnecting 63, 71
location 20
wireless button, identifying 14
wireless light, identifying 11, 16
wireless, product description 4
WLAN antennas, identifying 20
WLAN module
removal 69
spare part number 34, 35, 69
spare part numbers 25
workstation guidelines 43
WWAN antennas, identifying 20
WWAN cover
illustrated 29
removal 62
WWAN module
removal 62
spare part number 26, 34, 62

